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Chapter 62

Using the 
Fairlight Page 
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Using the Fairlight Page
This chapter covers the basic user interface controls found on the Fairlight page, where they 
are and what they do, in order to give you an overall orientation of how to work with this 
integrated audio environment.
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The Fairlight Page User Interface
In single monitor mode, the Fairlight page is an optimized look at the audio tracks of your 
project, with an expanded mixer and custom monitoring controls that make it easy to evaluate 
and adjust the levels of your program in order to create a smooth and harmonious mix.

Audio page

The Interface Toolbar
At the very top of the Fairlight page is a toolbar with buttons that let you show and hide different 
parts of the user interface. These buttons are as follows, from left to right:

The Interface toolbar

 � Media Pool: Shows and hides the Media Pool, from which you can edit audio clips into 
the Fairlight page timeline.

 � Effects Library: Opens the Audio FX panel of the Effects Library, from which you can 
apply VST and other audio effects to clips in the timeline.

 � Index: Shows and hides the Index and its Tracks and Markers panels. The Tracks panel 
lets you manage the tracks of the timeline, showing and hiding which ones you want 
to work with. The Markers panel lets you see every marker in the timeline, along with 
associated data, so that it’s easy to browse through your markers all at once to quickly 
find the information you need.

 � Mixer: Shows and hides the Mixer, to the right of the timeline, that lets you adjust 
various effects and levels associated with each track of the timeline in order to create a 
harmonious mix.

 � Monitoring: Shows and hides the Monitoring audio meters and viewer at the top of the 
Fairlight page.

 � Inspector: Show and hides the Inspector, from which you can edit different clip attributes.

 � Metadata: Shows and hides the clip metadata inspector, from which you can view. 
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The Audio Timeline
The heart of the Fairlight page, the Audio Timeline presents the audio channels and tracks of 
the currently selected timeline differently than the Edit page does, in a one-channel-per-track 
format that’s optimized for audio mixing and sweetening. The Audio page timeline cannot 
be closed.

The Audio page timeline

Controls in the Audio Timeline
The audio timeline has the following controls.

 � Timecode fields and Range buttons: Four timecode fields show the current timecode 
value corresponding to the position of the playhead (at the very top), the Range In 
point, the Range Out point, and the Range duration. Clicking the Range In and Range 
Out buttons (to the left of the timecode fields) set these points and their corresponding 
timecode value.

Timecode Fields and Range 
Buttons in the Fairlight page

 � Transport Controls: The bar defining the top of the timeline contains the Fairlight 
page’s audio-specific transport controls, which differ from those found on the Media, 
Edit, Color, and Deliver pages due to its inclusion of recording capabilities. These 
include Fast Reverse, Fast Forward, Play Forward, Stop, Record, and Loop.

Fairlight page transport controls
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 � Automation Toolbar: Clicking this button opens a secondary toolbar with all the 
controls you need to configure the recording of mixer automation.

Fairlight page automation toolbar

 � Monitoring Controls: At the far right of the transport controls, a set of three monitoring 
controls let you quickly control the output volume of your mix. An audio Enable/Disable 
button lets you turn audio playback on and off, while a slider lets you change the 
volume, and a DIM button lets you temporarily duck the monitored volume being output 
in order to have a quick chat with your client about sports or the state of the world while 
keeping half an ear on the mix.

The monitoring controls 

 � Timeline Ruler: The Timeline Ruler shows the program’s timecode. The playhead 
indicates the current frame and sample where you’re working in the Timeline, and 
the playhead has a handle that appears within the Timeline Ruler. Dragging within 
the Timeline Ruler moves the playhead. When you add markers to the timeline, these 
markers appear within the Timeline Ruler, as well.

 � Playhead: Shows the current frame and sample of playback, and provides a visual 
representation of where you are while playing, shuttling, and jogging through the 
timeline. Also used as a reference point for editing operations. The largest timecode 
display at the upper left-hand display shows the position of the playhead.

 � Audio Tracks: The Fairlight page of DaVinci Resolve supports multiple audio tracks, 
and each audio track may contain multiple lanes with which to accommodate the audio 
channels that are contained within multi-channel audio clips using track mappings such 
as stereo, 5.1, 7.1, or Adaptive (1-24 channels). All audio clips that have been edited into 
the Timeline appear within each track, with the recorded channels within each clip 
occupying as many lanes as that clip has available. At the left of each track is a header 
area that contains a number of controls.

The Fairlight timeline is divided into tracks and lanes, track A1 has a single lane for the 
mono audio within it, and track A2 has two lanes to accommodate stereo audio
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 � Track Header: The Track Header contains different controls for selecting, locking/
unlocking, and soloing/muting tracks. Each track header also lists how many clips 
appear on that track. The Track Header contains the following five controls, from 
left to right:

The track header controls of the 
Fairlight page timeline

Track Color: Each track can be color-coded with one of 16 different colors. These 
color codes correspond to the Edit page Mixer, and to the Fairlight page Mixer and 
Audio Meters. You can choose a new color for any track by right-clicking the track 
header and choosing from the Change Track Color submenu. You can set multiple 
tracks to the same color by Command-clicking in the track header of multiple tracks to 
select them, and then right-clicking one of the selected track headers and choosing 
from the Change Track Color submenu.

Track Number: Indicates the number of each track.

Track Name: Each track has a name that defaults to the track number, such as Track 1, 
Track 2. However, you can click any track’s name and edit it to be whatever you like. 
For example, you can rename each track with the type of audio you’re editing onto it, 
such as Production, Ambience, SFX, or Music. These track names are also used to 
identify each track’s channel in the Mixer, in the middle of each channel strip (each 
channel strip’s track number is simultaneously displayed at the top).

Audio channel type indicator: Audio tracks also show which channel configuration that 
track uses, listing the number of channels for mono, stereo, 5.1, 7.1, and adaptive.

Fader Value: A field displays the current fader setting at the position of the 
playhead, in dB.

Lock Track button: Light gray when turned on, dark gray when turned off. When a track 
is locked, clips can’t be replaced, moved, or otherwise edited, although clips on locked 
tracks can be graded.

Arm button: This button arms recording onto that track.

Solo button: Disables all other tracks but the current one, enabling you to quickly hear 
a single track in isolation. This affects rendering, so if one or more tracks are soloed, 
the muted tracks won’t be output or rendered.

Mute button:  Temporarily disables audio on that track so it’s neither monitored nor 
output. This affects rendering, so if one or more tracks are muted, they won’t be output 
or rendered.

Audio Meters: Each track has audio meters in the track header that let you see levels 
during playback.

 � Toolbar Editing Tools: The toolbar contains both modal and command buttons to let 
you work on your projects. More detail on these appears in the following section.

 � Vertical and horizontal scroll bars: If your project is longer than the current width of the 
Timeline, or the number of audio tracks is taller than the current height of the Timeline, 
these scroll bars let you drag to navigate around your program. When you scroll 
horizontally, you also move the playhead. You may also scroll vertically using the scroll 
wheel (or other scroll control) of your mouse or other pointing device. You may scroll 
horizontally by holding the Command key down while using your scroll control.



1104

U
si

ng
 t

he
 F

ai
rl

ig
ht

 P
ag

e
 

P
ar

t 
8

 –
 6

2

 � Individual Timeline track resizing: Any track in the Timeline can be individually resized 
by right-clicking anywhere within that track’s header control area and choosing a track 
height from the Lock Track Height To submenu of the contextual menu. You can choose 
a fixed size including Micro, Mini, Medium, Large, and Extra Large. When you choose 
a fixed track height, vertical zooming no longer affects that track until you change that 
track’s Lock Track Height to option back to None.

Resizing an individual Audio timeline track using contextual menu options

Track Layering
Audio layering is a special audio editing mode that lets you superimpose multiple audio clips in 
the same track, with audio clips edited into the top layers muting overlapping sections of audio 
clips appearing on lower layers. With audio layering enabled, superimposed audio clips are 
treated similarly to superimposed video clips that have opacity set to 100%, with clips on top 
obscuring (or muting) clips underneath. 

Turning on Track Layers opens up space to edit more audio into each track

Audio layering is incredibly useful for any situation where you’re combining segments of 
multiple takes together to create a single voiceover, audio vocal track, or dramatic performance, 
as you can choose which segments to use via their superimposed position in the stack of clips 
appearing in that track, while at the same time you’re preserving the other takes underneath in 
case you might want them later.

TIP: Track Layering can be enabled for audio tracks on the Edit page as well.
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Switching Among Multiple Timelines
Timelines can be organized like any other clip in the Media Pool. To open or switch among 
timelines, use the following procedures.

To switch timelines, do one of the following:

 � In the Edit page Media Pool, double-click a timeline.

 � In the Edit page Timeline Viewer, choose a timeline from the Timelines pop-up menu at 
the top of the viewer.

 � In the Color page, choose a timeline from the Timelines pop-up menu at the top of 
the viewer.

 � In the Fairlight page, choose a timeline from the Timelines pop-up menu to the left of 
the transport controls.

Toolbar
The Toolbar has buttons that let you choose modes of functionality and other buttons that let 
you execute commands such as placing markers and flags.

Buttons in the Fairlight Page Toolbar

 � Normal Edit Mode: The default mode in which you can move and resize clips in the 
Timeline, roll edits, and do other basic editing tasks.

 � Region Selection Mode: Performs an insert edit to the Timeline with whatever clip is in 
the Source Viewer.

 � Snapping: Enables or disables clip snapping. When turned on, clip In and Out points, 
markers, and the playhead all snap to one another for reference while you’re editing. 
A pop-up menu lets you choose how to use snapping to quantize clip position, to Bars, 
Beats, Divisions, Tics, or via Smart snapping. 

 � Flag Clip/Flag Colors pop-up menu: Flags identify clips, and indicate all clips that 
correspond to the same item of media in the Media Pool. Clips can have multiple flags. 
Clicking the Flag button automatically adds a flag to whichever clip is currently selected 
in the Timeline. A pop-up menu to the right lets you choose differently colored flags, 
and clear all flags from the currently selected clip.

 � Add Marker/Marker Colors pop-up menu: Markers identify specific frames of individual 
clips. Clicking the Add Marker button adds a marker of the currently displayed color 
to the clip at the position of the playhead in the Timeline. A pop-up menu to the right 
lets you choose differently colored markers, and clear all markers from the currently 
selected clip.

 � Customize Timeline pop-up menu: Contains a variety of controls with which to 
customize the display of clips in the Timeline. Zoom View Preset buttons let you choose 
from one of 7 zoom levels, and checkboxes let you show and hide flags and markers, 
full waveforms, and waveform borders.
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Selecting the Audio Timeline View options

 � Zoom Height slider: Lets you change the height of all tracks and clips in the Timeline 
at once. You can also zoom the height of timeline tracks by pressing the Command key 
while using the scroll control of your pointer, if it has such a control. The scroll wheel of 
a mouse is most common.

 � Zoom Width slider: Lets you shrink or expand the width of the contents of the Timeline. 
You can also control the width of the contents of the timeline using the scroll control of 
your pointer, if it has such a control. The scroll wheel of a mouse is most common.

Customizing Clip Display in the Timeline
Choose Fairlight > View Clip Info Display to open a dialog with which you can customize what 
information is shown at the bottom of each clip in the timeline. This dialog has options for 
viewing the Clip name vs. the Display Name, and for choosing from among a variety of 
metadata that you might want available as you work.

Selecting the Audio Clip View options
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Customizing the Timeline’s Display
There are a variety of ways you can customize the timeline to better see what you’re 
working on.

 � Zoom View Presets: Seven buttons let you choose one of seven zoom level presets.

 � Show Flags and Markers: A checkbox that lets you show or hide all flags and markers 
in the Fairlight timeline.

 � Show Full Waveforms: Lets you increase the height of audio waveforms into the space 
taken by the name bar of each clip.

 � Show Waveform Border: Enables a border around audio waveforms that make them 
more visible.

Mixer
The Audio Mixer provides a set of graphical controls you can use to assign track channels to 
output channels, adjust EQ and Dynamics, set levels and record automation, pan stereo and 
surround audio, and mute and solo tracks.

The Audio Mixer exposes two sets of channel strips with controls that correspond to the tracks 
in the Timeline. The left-most set of channel strips expose one set of controls for each track in 
the Timeline, while the right-most set of channel strips expose another set of controls for each 
Main and Sub (submix) you’ve created to bus the mixed audio tracks to whatever set of output 
tracks you want to expose.

The Audio Mixer, with channel strips 
corresponding to the tracks in the Timeline
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 � Track Color: Each track can be differently color-coded, to help you keep organized.

 � Track Number: The number of the timeline track corresponding to each channel strip 
appears here.

 � Input: A pop-up menu that lets you patch inputs, patch buses, and configure the input 
settings of audio signals routed through Blackmagic hardware interfaces.

 � Effects: VST and Audio Unit effects that you apply to tracks from the Effects Library 
appear here, with controls for enabling/disabling each effect, opening an effect’s 
custom controls, and deleting that effect.

 � Insert: Enables the routing of effects from Blackmagic audio interface hardware to 
outboard effects boxes and back again. This button can be toggled to enable/disable 
such routing.

 � EQ: Double-clicking exposes a four band parametric equalizer with additional Hi and 
Lo Pass filters, that has both graphical and numeric controls for boosting or attenuating 
different ranges of frequencies of audio on each track. You can select from among four 
types of EQ filtering from the Equalizer Type pop-up menu, with options for Earth (the 
default), Air, Ice, and Fire. Each band has controls for the filter type (Bell, Lo-Shelf, Hi-
Shelf, Notch), Frequency, Gain, and Q-factor (sharpness of the band), with the available 
controls for each band of EQ change depending on the filter type.

The channel strip EQ window

 � Dynamics: Double-clicking exposes a set of dynamics controls with three sets of 
controls corresponding to an Expander or Gate, a Compressor, and a Limiter that can 
be used separately or in concert to manage the dynamics of the audio on that track.
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The channel strip Dynamics control window

 � Aux: Each Aux bar corresponds to a specific Aux bus that you created. Double-clicking 
any of these bars opens up the Auxiliaries window, with which you can enable or 
disable auxiliaries, set each one to be routed Pre the channel strip or Post the channel 
strip (the default), and set each Aux buses Send level and Pan value.

The Auxiliaries control window

Whatever level you set an Aux bus will be shown in the bar that represents that Aux bus 
in the Mixer’s channel strip.

The Auxiliaries levels shown in the 
channel strip of the Mixer

 � Pan: A pan control compatible with stereo and surround panning. You can drag within 
this control to adjust pan, or you can double-click to expose a pan window. What 
controls are available in the pan window depend on the mapping of the audio track, 
but both stereo and surround panning controls are available, with corresponding 
numeric controls.
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The Pan control window

 � Main: These buttons let you assign a track or Sub’s channels to one or more of the 
main buses.

 � Submix: These buttons let you assign that track’s channels to one or more 
submix buses.

 � Track Name: This mirrors the track name found in the header controls of the timeline. If 
you customize a track’s name in the timeline, that name appears here.

 � dB: Shows you the volume, in decibels, that track is currently set to.

 � Arm, Solo, and Mute buttons: Identical to the controls found in the track header 
controls of each timeline audio track. Arm lets you enable a track to be recorded onto. 
Solo lets you mute all other tracks in order to play that track in isolation (along with any 
other Soloed tracks). Mute disables audio playback from that track.

 � Fader: Each track’s vertical faders let you adjust the volume of that track, and perform 
automation recording.

The Monitoring Panel
The Monitoring panel that runs along the top of the Fairlight page shows all of the audio meters 
corresponding to the tracks in the timeline, as well as the Master Output meter, control room 
meters, and a video viewer.

The Monitoring panel

At left, a row of audio meters corresponds to the channel strips of the Mixer, one meter for 
every audio track in the timeline. Each track displays the number of meters that corresponds to 
that track’s audio mapping, with mono tracks having a single audio meter, stereo tracks having 
two, 5.1 tracks having six, etcetera. All of these track and bus meters (with the exception of the 
Loudness meters) display both peak and RMS (root mean square) levels against a dB scale.
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To the right of the Track meters are the Bus meters, in which all Mains, Subs, and Aux buses 
appear, separated by type, and each displaying the number of meters that corresponds to that 
track’s audio mapping. This way you can see the sum of all tracks that have been routed to a 
particular bus.

The last set of meters, to the right of all others, are the Loudness meters, which consist of two 
sets of meters and a numerical readout. These meters let you keep track of the integrated 
loudness of the overall mix, which is the standard to which all contemporary mixing 
specifications refer when describing the deliverables you’re expected to provide to the client.

Viewer
A small viewer to the left of the Monitoring panel shows the frame of video at the position of the 
playhead. The only available control is a button in the lower right-hand corner that lets you 
expand the Viewer into its own floating window.

The Monitoring panel.

The Media Pool
In the Fairlight page, the Media Pool serves as the repository of all audio clips in your project, 
both clips that appear within the timeline, and clips that you’ve added to your project but have 
not yet used. When you record audio into the timeline, the resulting clips are stored in the 
Media Pool as well, for future use. The Media Pool is also mirrored on the Media and Edit pages, 
and contains all of the video clips and timelines within that project. 

The Bin list at the left shows a hierarchical list of bins used for organizing your media, which is 
also used to organize your timelines. By default, the Media Pool consists of a single bin, named 
“Master,” but you can add more bins as necessary to organize timelines and clips by right-
clicking anywhere in the empty area of the Media Pool and choosing Add Bin. You can rename 
any bin by double-clicking on its name and typing a new one, or by right-clicking a bin’s name 
and choosing Rename Bin. The Bin list can be hidden or shown via the button at the upper 
left-hand corner of the Fairlight page toolbar.

The browser area to the right shows the contents of the currently selected bin in the bin list. 
Every clip you import, every timeline you create, and every AAF, XML, or EDL file you import 
appears here. You can create or import as many timelines as you need within a single project.
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The Media Pool in Thumbnail mode showing audio clips

As elsewhere, the Media Pool can be displayed in either Icon or List view. In List view, you can 
sort the contents by any one of a subset of the total metadata that’s available in the Metadata 
Editor of the Media page. Of particular interest to audio editors are columns for Name, Reel 
Name, different timecode streams, Description, Comments, Keyword, Shot, Scene, Take, Angle, 
Circled, Start KeyKode, Flags, and Usage.

For more information on using the myriad features of the Media Pool, see Chapter 8, “Adding 
and Organizing Media with the Media Pool.” In the sections that follow, some key features of the 
Media Pool are summarized for your convenience.

Importing Media Into the Media Pool on the Fairlight Page
While adding clips to the Media Pool in the Media page provides the most organizational 
flexibility and features, if you find yourself in the Edit or Fairlight pages and you need to quickly 
import a few clips for immediate use, you can do so in a couple of different ways.

To add media by dragging one or more clips from the Finder to the Fairlight page Media Pool 
(macOS only):

1 Select one or more clips in the Finder.

2 Drag those clips into the Media Pool of DaVinci Resolve, or to a bin in the Bin list.

Those clips are added to the Media Pool of your project.

To use the Import Media command in the Fairlight page Media Pool:

1 With the Fairlight page open, right-click anywhere in the Media Pool, and choose 
Import Media.

2 Use the Import dialog to select one or more clips to import, and click Open.

Those clips are added to the Media Pool of your project.
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For more information on importing media using the myriad features of the Media page, see 
Chapter 8, “Adding and Organizing Media with the Media Pool.”

Bins, Power Bins, and Smart Bins
There are actually three kinds of bins in the Media Pool, and each appears in its own section of 
the Bin list. The Power Bin and Smart Bin areas of the Bin list can be shown or hidden using 
commands in the View menu (View > Show Smart Bins, View > Show Power Bins). Here are the 
differences between the different kinds of bins:

 � Bins: Simple, manually populated bins. Drag and drop anything you like into a bin, 
and that’s where it lives, until you decide to move it to another bin. Bins may be 
hierarchically organized, so you can create a Russian dolls nest of bins if you like. 
Creating new bins is as easy as right-clicking within the bin list and choosing Add Bin 
from the contextual menu.

 � Power Bins: Hidden by default. These are also manually populated bins, but these 
bins are shared among all of the projects in your current database, making them ideal 
for shared title generators, graphics movies and stills, sound effects library files, music 
files, and other media that you want to be able to quickly and easily access from any 
project. To create a new Power Bin, show the Power Bins area of the Bin list, then right-
click within it and choose Add Bin.

 � Smart Bins: These are procedurally populated bins, meaning that custom rules 
employing metadata are used to dynamically filter the contents of the Media Pool 
whenever you select a Smart Bin. This makes Smart Bins fast ways of organizing the 
contents of projects for which you (or an assistant) has taken the time to add metadata 
to your clips using the Metadata Editor, adding Scene, Shot, and Take information, 
keywords, comments and description text, and myriad other pieces of information to 
make it faster to find what you’re looking for when you need it. To create a new Smart 
Bin, show the Smart Bin area of the Bin list (if necessary), then right-click within it and 
choose Add Smart Bin. A dialog appears in which you can edit the name of that bin and 
the rules it uses to filter clips, and click Create Smart Bin.

Showing Bins in Separate Windows
If you right-click a bin in the Bin List, you can choose “Open As New Window” to open that bin 
into its own window. Each window is its own Media Pool, complete with its own Bin List, Power 
Bins and Smart Bins lists, and display controls. 

This is most useful when you have two displays connected to your workstation, as you can drag 
these separate bins to the second display while Resolve is in single screen mode. If you hide 
the bin list, not only do you get more room for clips, but you also prevent accidentally switching 
bins if you really want to only view a particular bin’s contents in that window. You can as many 
additional Bin windows open as you care to, in addition to the main Media Pool that’s docked in 
the primary window interface.

Filtering Bins Using Color Tags
If you’re working on a project that has a lot of bins, you can apply color tags to identify particular 
bins with one of eight colors. Tagging bins is as easy as right-clicking any bin and choosing the 
color you want from the Color Tag submenu.

For example, you can identify the bins that have clips you’re using most frequently with a red 
tag. A bin’s color tag then appears as a colored background behind that bin’s name.
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Using Color Tags to identify bins

Once you’ve tagged one or more Media Pool bins, you can use the Color Tag Filter pop-up 
menu (the pop-up control to the right of the Bin List button) to filter out all but a single 
color of bin.

Using Color Tag filtering to isolate the blue bins

To go back to seeing all available bins, choose Show All from the Color Tag Filter pop-up.

Sorting the Bin List
The Bin list (and Smart Bin list) of the Media Pool can be sorted by bin Name, Date Created, or 
Date Modified, in either ascending or descending order. Simply right-click anywhere within the 
Bin list and choose the options you want from the Sort by submenu of the contextual menu.
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You can also choose User Sort from the same contextual menu, which lets you manually drag all 
bins in the Bin list to be in whatever order you like. As you drag bins in this mode, an orange line 
indicates the new position that bin will occupy when dropped.

Dragging a bin to a new position 
in the Bin list in User Sort mode

If you use User Sort in the Bin list to rearrange your bins manually, you can switch back and forth 
between any of the other sorting methods (Name, Date Created, Date Modified) and User Sort 
and your manual User Sort order will be remembered, making it easy to use whatever method 
of bin sorting is most useful at the time, without losing your customized bin organization.

Filtering Clips With Audio in the Fairlight Page
The Media Pool in the Fairlight page has one additional feature: the ability to filter out audio-
only clips, or clips with audio, in the currently selected bin. This makes it easy for you to find 
audio clips that you’re looking for, which are hidden along with lots of video clips in the same 
bin. To use this feature, click the Option menu of the Media Pool and choose Show All Clips, 
Show Audio Only Clips, or Show Clips With Audio. 

The Media Pool filter options in the option menu

Searching for Content in the Media Pool
An optional Search field can be opened at the top of the Media Pool that lets you quickly find 
clips by name, partial name, or any of a wide variety of Media Pool metadata. 
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To search for a clip by name:

1 Select which bin or bins you want to search.

2 Click the magnifying glass button at the upper right-hand corner of the Media Pool.

3 Choose the particular column of information you want to search (or All Fields to search 
all columns) using the Filter by pop-up menu. Only selected bins will be searched.

4 Type your search string into the Search field that appears. A few letters should be 
enough to isolate only those clips that have that character string within their name. 
To show all clips again, click the cancel button at the right of the search field.

Taking Advantage of the Media Pool’s Usage Column
In List view, the Usage column does not automatically update to show how many times a 
particular clip has been used. However, you can manually update this metadata by right-clicking 
within the Media Pool and choosing Update Usage Data from the contextual menu that 
appears. Afterwards, each clip will display how many times it’s been used in this column. 
Clips that have not been used yet display an x.

Effects Library
The Effects Library on the Fairlight page is restricted to displaying only the Audio FX that are 
available on your workstation. On Mac OS X and Windows, DaVinci Resolve supports the use of 
third-party VST audio plug-ins. On Mac OS X, DaVinci Resolve supports Audio Unit (AU) audio 
plug-ins. Once you install these effects on your workstation, they appear in this panel of the 
Effects Library. Audio plug-ins let you apply effects to audio clips or entire tracks worth of audio, 
to add creative qualities such as echo or reverb, or to take care of mastering issues using noise 
reduction, compression, or EQ.

TIP: Smart Bins are essentially multi-criteria search operations that scope the entire 
project at once and are saved for future use.
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The Effects Library

Similar to the Media Pool, the Effects Library’s bin list can be opened or closed using a button 
at the top left.

Effects Library Favorites
You can click on the far right of any transition, title, or generator to flag that effect with a star as 
a favorite effect. When you do so, the favorited effects appear in a separate Favorites area at 
the bottom of the Effects Library Bin List.

Stars indicate a flagged favorite effect, all favorites are currently filtered

Index
The Index provides a handy interface for listing all of the clips in the current edit, all the tracks in 
the current timeline, and all the markers in the current timeline. Using these lists, multiple items 
can be selected, tracks can be managed, and marker notes can be consulted with ease. Each 
of these three categories of information is displayed in separate panels:
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 � Tracks: Every track in the currently open timeline corresponds to a row of controls and 
information in this panel. From left to right, each track has a visibility control, a color 
control, a number, a name, a format, and a group that it belongs to.

The tracks panel shows a row of information for each of the tracks in the timeline

 � Markers: The markers panel can be displayed in either thumbnail or list mode. In 
thumbnails mode, each marker in your timeline corresponds to a thumbnail displaying 
the timecode of its location underneath it, and the color of the marker to the left of 
the timecode location. In list view, each marker displays a row with the following 
information; marker number, frame (showing a thumbnail), marker name, start timecode, 
end timecode, duration, marker color, and notes.

The markers panel shows a row of information for each of the markers in the timeline

Inspector
When you add an audio effect to a clip or a track, those effects appear in the Inspector when 
that clip or track is selected.
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Metadata Editor
Lets you view and edit the metadata of selected clips in the Fairlight page.

Dual Monitor Layout
The Audio page has a dual monitor layout that provides maximum space for the mixer and 
audio meters on one screen and a full-screen timeline on the other.

To enter dual screen mode:

Choose Workspace > Dual Screen > On. 

The Fairlight page in dual screen mode

To switch which UI elements appear on which monitors:

Choose Workspace > Primary Display > Display 1 or Display 2, which reverses the 
contents of both monitors in dual screen mode.
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Customizing the Fairlight Page
The default layout is quite efficient for a number of tasks on most displays. You can always 
return to the default layout by choosing Workspace > Reset UI Layout. However, the Fairlight 
page can be customized to create more room for specific areas of the interface to 
accommodate different tasks.

To resize any area of the Fairlight page:

Drag the vertical or horizontal border between any two panels to enlarge one and 
shrink the other.

To resize the height of individual audio tracks:

Move the pointer to the bottom border of any audio track header, and when it becomes 
a resize cursor, drag that border up or down to resize that track. Each track can have an 
independent size when you do this.

To resize any column of the Index: 

Move your pointer over the divider between any two columns and drag when the 
horizontal resize cursor appears.

To rearrange Index columns: 

Drag the header of any column to the left and right to move that column.

Undo and Redo in the Fairlight Page
The Fairlight page shares its multiple-undo stack with the Edit page. However, the Fairlight and 
Edit page undo stack is entirely separate from the multiple-undo stacks maintained for each clip 
in the Color page, making it easy and reliable to undo edits and other changes you make in the 
Timeline without disturbing your work in the Color page. There are two ways you can undo.

To undo and redo:

Press Command-Z to Undo, and Shift-Command-Z to Redo.

To undo and redo using the Undo list:

1 Choose Edit > Undo List.

2 When the History dialog appears, click an item on the list to undo back to that point. 
The most recent thing you’ve done appears at the bottom of this list.

The Undo List

3 When you’re done, close the History window.
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Chapter 63

Setting Up 
Tracks, Buses, 
and Patching 
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Setting Up Tracks, Buses, and Patching
One of the first things you need to do when you’re setting up a new project for mixing in the 
Fairlight page is to define all of the audio tracks and buses you’re going to need, including 
submixes and mains that route and combine the audio being output. This chapter covers how to 
create audio tracks, and how to use buses to manage your mixes in the most efficient 
possible way.

Audio Tracks 1123

What is a Bus? 1124

Types of Buses 1124

Controlling Signal Flow 1125

Managing Audio Tracks 1125

Defining Timeline Audio Track Channels at Creation 1125

Creating Tracks 1125

Rearranging Tracks 1126

Changing How Many Channels an Audio Track Has 1126

Deleting Tracks 1126

Linked Group Support for Mono Tracks 1126

Creating Buses 1128

Assigning Buses 1129

Patching Signal Paths 1130

Using a Channel Strip’s Input Menu 1132
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Audio Tracks
Each audio track in a Resolve timeline corresponds to a single channel strip on the Mixer’s left 
side. Depending on how an audio track has been configured, each audio track is assigned a 
specific audio format such as stereo, LCRS, 5.1 surround, or 7.1 surround, so that multiple audio 
channels within the clips on that track can be correctly routed to the proper audio output for 
monitoring and rendering via the lanes that can be seen within each track on the 
Fairlight timeline.

Audio tracks in DaVinci Resolve have been designed to contain multiple channels of clip audio 
within a single track, but how those individual audio channels are displayed depends on the 
page. The Edit page hides these individual audio channels, displaying only a single clip in the 
timeline to make it easier to edit multi-channel sources without needing to manage a huge 
number of tracks. However, the Fairlight page has a unique Track and Lane system for 
displaying audio. 

The Fairlight page displays the same number of tracks as the Edit page, but each track on the 
Fairlight page is divided into lanes, which expose each individual channel of clip audio for 
editing and mixing.

(Top) Stereo audio in the Edit page represented by a single track (Right) The same stereo audio in the Fairlight 
page shows the two lanes that correspond to each of the stereo audio tracks

Now that you understand how tracks work on the Fairlight page, the next important concept 
you need to understand in order to unlock the power of the Fairlight page is the audio bus, 
which lets you combine multiple audio tracks in different ways.



1124

S
e

tt
in

g
 U

p
 T

ra
ck

s,
 B

us
e

s,
 a

nd
 P

at
ch

in
g

 
P

ar
t 

8
 –

 6
3

What is a Bus?
In audio postproduction, a bus is essentially a destination channel to which you can route 
multiple audio feeds (typically the audio tracks in the timeline) so they are mixed together into a 
single signal that can be controlled via a single channel strip.

For example, if you have five audio channels into which have been edited all of the dialog audio 
clips for a particular program, you can route the output of all five dialog tracks to a Submix bus, 
which combines them so that all dialog can then be mixed with a single set of controls.

There are multiple levels of busses. For example, individual tracks can be routed to Submix 
busses, as described above. Additionally, multiple Submixes can be routed to one or more 
Mains. For example, you could have four submix busses, one for German dialog, one for English 
dialog, one for Music, and one for Effects. You could route the German, Music, and Effects 
submix busses to Main 1 for the German version of the program, and route the English, Music, 
and Effects submix busses to Main 2 for the English language version of the program.

Audio tracks from the timeline are routed to buses via each channel strip’s multiformat surround 
panner, so buses are configured to accommodate specific audio formats such as stereo, LCRS, 
5.1 surround, or 7.1 surround. 

Types of Buses
There are four types of busses in DaVinci Resolve.

Mains
Main busses are typically the primary output of a program; each new project you create starts 
out with a single Main called M1, to which all tracks are routed by default. You can add 
additional Mains, and you can use them however you like, as either full or partial mixes of the 
program you’re working on. Mains can be directly output in the deliver page.

Sub (Submix)
Sub busses are often the means by which multiple tracks of audio that belong to the same 
category (dialog, music, effects, ambience, etcetera) are combined together so that everything 
in that category can be mixed as a single audio signal. Multiple Sub busses can be themselves 
routed to Main busses, or they can be directly output in the deliver page.

Aux (Auxillary)
Each channel strip includes twelve auxiliary bus sends, which are typically used to route audio 
to software or hardware effects of some kind. To understand how Aux sends fit into the audio 
processing path, auxiliary send signals are connected either immediately before or after a 
channel strip’s fader. Each auxiliary bus can also be configured to accommodate specific audio 
formats such as stereo, LCRS, 5.1 surround, or 7.1 surround.

Multi Track
Multitrack buses provide bus paths for combining feeds that you want to re-record to disk, or 
route to other I/O.



1125

S
e

tt
in

g
 U

p
 T

ra
ck

s,
 B

us
e

s,
 a

nd
 P

at
ch

in
g

 
P

ar
t 

8
 –

 6
3

Controlling Signal Flow
The process of setting yourself up for editing and mixing in the Fairlight page involves: 

 � First, customizing the tracks of the timeline to be organized and configured as required.

 � Second, creating the busses you need in order to organize your signal flow.

 � Third, patching the tracks to Subs, and the Subs to Mains, in order to create the signal 
flow you need.

Managing Audio Tracks
When you’re getting ready to record or edit audio clips into the Fairlight Timeline, you need to 
make sure you’ve got enough tracks to do the job. The following procedures cover the different 
methods available for adding, removing, and rearranging tracks as you work. These commands 
are all available via the contextual menu that appears when you right-click anywhere in the 
Timeline header area (the header of the Timeline is the area to the left where each track’s 
various buttons and controls are located).

Defining Timeline Audio Track Channels at Creation
If you decide to create a new audio track, you have to choose what kind of audio track it will be. 
Right-clicking in the bottom audio portion of the Timeline track header reveals a contextual sub-
menu that lets you create one of three different kinds of audio tracks.

 � Mono: Holds a single channel with only one lane.

 � Stereo: Holds stereo left and right channels, with two lanes

 � 5.1: Holds the six channels corresponding to a 5.1 surround mix, for a total of six lanes. 
For broadcast, SMPTE specifies Left, Center, Right, Left Surround, Right Surround, and 
LFE. For cinema distribution these tracks are ordered Left, Right, Center, LFE, Surround 
Left, Surround Right, and LFE.

 � 7.1: Holds the eight channels corresponding to a 7.1 surround mix, for a total of eight 
lanes. For broadcast, SMPTE specifies Left, Center, Right, Left Surround, Right 
Surround, LFE, Back Surround Left, and Back Surround Right. For cinema distribution 
these tracks are ordered Left, Right, Center, LFE, Left Surround, Right Surround, Back 
Left Surround, and Back Right Surround.

 � Adaptive: Capable of holding up to 24 audio channels, which would display up 
to 24 lanes within the track. An adaptive audio track can hold clips with different 
combinations of channels, up to the maximum number of channels allowed within 
that track. The number of channels allowable on a particular Adaptive track is user-
definable (1–24) at the time that track is created. If you edit a clip with more channels 
into an Adaptive track that was created to hold fewer channels, the extra clip channels 
are muted.

Creating Tracks
There are two commands with which to create new audio tracks, and both are in the contextual 
menu found by right-clicking within any audio track’s header controls. Add Track adds a single 
audio track of the type you choose from a submenu. Add Tracks lets you insert as many tracks 
as you like, of a type and at a position you designate using the Add Tracks dialog.
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Rearranging Tracks
You can rearrange tracks by right-clicking in a track’s header area and choosing either Move 
Track Up or Move Track Down in the contextual menu that appears.

Changing How Many Channels an Audio Track Has
If you had set up your timeline with one kind of audio track, but you discover you actually need 
a different kind, you can change any audio track’s type at any time. Just right-click anywhere in 
that audio track’s timeline header, and choose an option from the Change Track Type To 
submenu of the contextual menu.

Deleting Tracks
Right-click within a track’s Timeline header and choose Delete Track. If there are clips on a 
track you remove, they are also deleted from the Timeline, but preserved in the Media Pool.

Linked Group Support for Mono Tracks
Linked Groups are an organizational construct that you can create using mono tracks (other 
kinds of tracks such as stereo, 5.1, 7.1, or Adaptive cannot be used in a Linked Group). Unlike a 
multi-channel track with lanes, a Linked Group of mono tracks functions as five independently 
editable tracks in the Timeline. However, each track is mapped just like an audio channel using 
one of the standard multi-channel mappings (stereo, 5.1, 7.1, Adaptive), and Linked Groups of 
mono tracks are mixed using only a single channel strip.

Linked Groups are extremely useful when you’ve been given a set of six independent audio 
files that need to be assembled as a single surround mix, or when you have surround channels 
that need to be specifically re-edited on a channel by channel basis.

To create a Linked Group:

1 Create two or more Mono audio tracks that you want to group together. If you need 
to create a Linked Group with a specific channel mapping, such as 5.1, make sure you 
create enough tracks (in this case, 6).

2 Choose Fairlight > Link Group.

3 When the Link Group dialog appears, Mono audio tracks are represented by active 
buttons (all other channel mapped tracks are disabled, since they can’t be linked). Click 
to enable the button of every track you want to include in the group you’re about to 
create. Which mappings are available to use for creating your group depends on how 
many tracks you’ve selected.

 

Selecting six tracks to use for creating a Link Group

4 After you’ve selected all the tracks you need to, click one of the available “Link as” 
buttons below. In this example, six tracks have been selected, so you could click 5.1 
Film or 5.1.
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When you select enough tracks, you can create groups 
linked as specific surround mappings

Afterwards, the tracks you selected should turn into a single block, showing they’ve 
been linked.

When you select enough tracks, you can create groups linked as specific surround mappings

5 Close the Link Group window when you’re finished.

Once you’ve created a Linked Group, the mono tracks in the timeline that you linked appear 
with a bar to the left in the track header that spans every track that’s linked. If the tracks are tall 
enough, they’ll also be labeled to identify which track corresponds to which surround channel, 
L, R, C, Lfe, Ls, Rs, etcetera.

Tracks in a linked group are labeled to identify which 
track corresponds to which surround channel

If necessary, you can also unlink a linked group to turn it back into independent mono tracks.
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To unlink a linked group:

1 Choose Fairlight > Link Group.

2 When the Link Group dialog appears, select the linked group you want to unlink.

3 Click Unlink.

4 Close the Link Group window when you’re finished.

Creating Buses
Choosing Fairlight > Bus Format opens the Bus Format window, which lets you create as many 
busses as you need (up to the limitations of your system) to organize the tracks and channels of 
your program.

The Bus Format window lets you add busses to the mixer

Four buttons at the top of the window let you create any type of bus Fairlight supports. Creating 
a new bus, whether it’s a Main, Sub, Aux, or Multi Track, adds the new bus to the list that 
appears below.

The Bus list lets you rename the bus, choose the format of each bus (a pop-up menu appears in 
the Format column of each entry of the list), and color-code each bus (a Color pop-up lets you 
choose that bus’s color). Simply click any item on the Bus list to select it, and choose different 
options from the Format and Color pop-up menus, or click on the User Name of any bus to 
select it, and type a custom name.

At the bottom of the list are two additional buttons that let you Duplicate or Remove selected 
Buses. When you’re done modifying the available busses, you can click OK to accept the 
change and close the Bus Format window, Cancel to close the window (although any busses 
you’ve made remain in place, or Bus Assign to open the Bus Assign window,.
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Assigning Buses
Once you’ve created one or more busses, you’ll want to assign different tracks to specific 
busses, and different Subs to specific Mains. This is accomplished in the Bus Assign window, 
which you can open by choosing Fairlight > Bus Assign, or by clicking the Bus Assign button in 
the Bus Format window.

The Bus Assign window lets you choose which tracks are connected to 
which busses, and which busses are connected to which mains

The top shows all of the available Main, Sub, and Multi Track busses, while the bottom shows all 
available tracks, Sub busses, and Aux busses. The Bus Assign window defaults to icon view, in 
which each Bus and Track is shown as a button, but it can be switched to list view, in which the 
Available Tracks section is shown as a list.

Methods of making bus assignments:

 � To assign specific tracks to a bus: Click a button in the Buses section to select that 
bus, and then either click or drag a bounding box over all the available tracks that you 
want to assign to that bus. Once assigned, the Available Tracks buttons display which 
Bus they’ve been assigned to.

Assigning multiple tracks to a bus by dragging a bounding box



1130

S
e

tt
in

g
 U

p
 T

ra
ck

s,
 B

us
e

s,
 a

nd
 P

at
ch

in
g

 
P

ar
t 

8
 –

 6
3

 � To assign every track, Sub, and Aux to a bus: Click a button in the Buses section to 
select that bus, and then click Assign All.

 � To clear all track assignments from a particular bus: Click a button in the Buses 
section to select that bus, and then click Un-Assign All.

When you’re done making bus assignments, click Save.

Patching Signal Paths
While bus creation and assignment is a straightforward way of creating a cascade of routing 
from tracks to Subs to Mains, sometimes you need to create more specific signal paths. For 
example, if you need to record audio to a track, you need to patch the audio input you want to 
record from to the track you want to record to. This, and many other scenarios, are 
accomplished using the Patch Input/Output window.

Using the Patch Input/Output Window

Choosing Fairlight > Patch Input/Output opens the Patch Input/Output window, which can be 
displayed in either icon or list view. This window is split into two halves, with the left half 
containing whichever Audio Source controls you choose, and the right half containing 
whichever Audio Destinations you choose. In the following screenshot, the Audio Inputs from a 
Scarlett2i2 USB audio interface are shown, while the available Track Inputs are shown to 
the right.

The Patch Input/Output Window showing Audio Inputs and Track Inputs
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Creating a Patch
By default, the Patch Input/Output window shows the available Audio Inputs as the Source, and 
the Track Inputs as the Destination. This makes it easy to patch whatever audio source (such as 
a microphone connected to a USB audio interface) to a specific audio track of the timeline to 
prepare for recording. Patching and Un-Patching a source to a destination is straightfoward.

To patch a source to a destination:

1 Click the button or list item of the source you want to patch on the left side of the Patch 
Input/Output window.

2 Click the button or list item of the destination you want to patch on the right side.

A selected Audio Source and Audio Destination pair

3 Click the Patch button at the bottom right of the window. The Source and Destination 
will both display the connection they’re patched to.

To un-patch a source and destination pair:

1 Click the button or list item of a source or destination you want to un-patch.

2 Click Un-Patch.

Choosing Audio Source and Destination Controls
The Audio Source and Destination pop-up menus let you choose different categories of source 
and destination controls to patch together.

The following Audio Source options are available:

 � Audio Inputs: The available physical audio inputs on your workstation, for example 
SX-36, MADI, or system audio. Useful when patching to record audio.

 � Track Repro: Short for Reproduction, this is the signal from the track playback, before 
any processing

 � Track Send: Track Insert send

 � Track Direct: Track Direct Out, can be pre- or post the track fader, with an offset

 � MT-Bus Dir: Multitrack Bus Direct Out, can be pre- or post the multitrack bus master 
fader, with an offset

 � MT-Bus Out: Multitrack Bus Out, always post the Multitrack bus master fader

 � Aux-Bus Send: Aux bus master insert send

 � Aux-Bus Dir: Aux Bus Direct Out, can be pre- or post the Aux bus master fader, 
with an offset

 � Aux-Bus Out: Aux Bus Out, always post the Aux bus master fader

 � Sub-Bus Send: Sub bus master insert send

 � Sub-Bus Dir: Sub Bus Direct Out, can be pre- or post the Sub bus master fader, 
with an offset
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 � Sub-Bus Out: Sub Bus Out, always post the Sub bus master fader

 � CR-Mon Dir: Monitor system Direct out. Post fold up/down matrix, pre the Monitor 
VolumeLevel/Dim/Mute

 � CR-Mon Out: Monitor system output. Post fold up/down matrix and Monitor 
VolumeLevel/Dim/Mute

 � Main Send: Main bus master insert send

 � Main Dir: Main Bus Direct Out, can be pre- or post the Main bus master fader, 
with an offset

 � Main Out: Main Bus Out, always post the Main bus master fader

 � Osc: Oscillator outputs. Sine, Pink noise, White noise

 � Solo Out: AFL and PFL Solo Bus Out, always post the respective bus master fader 

The following Audio Destination options are available:

 � Track Input: Input to the Record and Thru path; simply put, the available audio tracks in 
the current timeline

 � Track Return: Track Insert Return

 � Aux-Bus Return: Aux Bus master insert return

 � Sub-Bus Return: Sub Bus master insert return

 � Main Return: Main Bus master insert return

 � CR-Mon In: Input to the Monitor system’s fold up/down matrices

 � Talk Back: The Talkback system, showing Comm1 and Comm2

 � Audio Outputs: The available physical audio outputs on your workstation, for example 
SX-36, MADI, or system audio

Using a Channel Strip’s Input Menu
The Input pop-up menu at the top of each track’s channel strip in the mixer provides some 
shortcuts for patching different inputs and buses to the tracks of your mix. Each option in this 
menu makes the Patch Input/Output window appear with different Audio Source and Audio 
Destination selections automatically set up.

Input
The Patch Input/Output window appears set up to let you patch different inputs (such as the 
system audio input) to the tracks of the timeline. This makes it fast for setting up audio inputs in 
preparation for recording.

Aux Bus
The Patch Input/Output window appears set up to let you patch different Aux buses to specific 
submix and timeline track channels.

Sub Bus
The Patch Input/Output window appears set up to let you patch different Sub (submix) bus 
channels to specific timeline track channels.

Main Bus
The Patch Input/Output window appears set up to let you patch different Main bus channels to 
specific timeline track channels.
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Input Settings
Choosing Input Settings opens the Path Settings window for that track. This window contains 
controls for adjusting the input level of audio signals being input via a BMD input/output device.

The Patch Input/Output Window showing Audio Inputs and Track Inputs

These parameters control the following:

 � Mic/Instr.: Adjusts the Mic/Instrument level for this source, from 0 to 100 dB.

On: Enables Microphone/Instrument level for this source.

48V: Enables phantom power for that input.

 � Record Level: Controls the level going to the Disk before recording. It does not affect 
the track when in Thru mode.

Rec: Enabling this button makes this track ready to record. Only turn this on if there is 
an audio source patched to the current track.

Thru: When on, this makes the affected track into the equivalent to a Live Feed. When 
enabled, this track will monitor its input, but will not respond to a record command. Only 
turn this on if there is an audio source patched to the current track.

 � Trim: This parameter controls the level as the channel enters the mixer. For timeline 
tracks, this controls the signal coming from disk, and does not affect any current levels 
being recorded.

 � Direct Output: Controls the level going from this channel to the Direct Output.

On: Toggles direct output on and off.

Pre: Toggles the Direct Output to connect either pre or post the main channel fader.

 � Insert: Controls the Insert Return only. When enabled, the channel connects to its 
Insert Return, otherwise the Channel connects to the straight-through path. The Insert 
Send, on the other hand, is always active (though it must be patched somewhere 
before it can be heard). 

NOTE: Insert sends and returns are only audible if patched to physical outputs or 
inputs, or to other paths. Sends can be sent to the input of any path in the system, and 
returns can come from the output or send of any path. This is done in the Patch I/O 
screen (press the Patch I/O button).
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Chapter 64

Transport 
Controls, Timeline 
Navigation, 
and Markers 
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Transport Controls, 
Timeline Navigation, and Markers
The Fairlight page has unique transport control, zooming, and scrolling options not found in the 
other pages of DaVinci Resolve that help you to work with audio more efficiently. This chapter 
covers how to get around the Fairlight version of the timeline.

Transport Controls and JKL Navigation 1136

Transport Controls 1136

Using JKL to Control Playback 1136

Dragging the Playhead to Scrub 1137

Looping Playback 1137

Clip, Marker, and Track Navigation 1137

Selecting Tracks 1137

Left and Right Arrow Keys 1137

Up and Down Arrow Keys 1138

Zooming and Scrolling 1138

Setting the Zoom Level of the Timeline 1138

Scrolling Through the Timeline 1138

Using Flags 1139

Using Markers 1139

Adding Markers to Clips 1139

Adding Markers to Timelines 1140
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Transport Controls and JKL Navigation
Because of the Fairlight page’s audio-focused workflow, the transport and playback controls 
differ from those found in the Media, Edit, Color, and Deliver pages.

Transport Controls

Fairlight page transport controls

The Fairlight transport controls are also designed to mirror their counterparts on the Fairlight 
control panels. They include the following functions:

 � Rewind and Fast Forward: Initiates accelerated playback through the timeline in either 
direction. Pressing either of these buttons multiple times speeds up this motion, cycling 
through 8x, 24x, 60x, 150x, and 360x play speeds.

 � Play: Plays forward. Identical to pressing the Space bar or L keys while playback 
is stopped.

 � Stop: Stops playback. Identical to pressing the Space bar or K keys while playback 
is engaged.

 � Record: Initiates recording if you have an audio source patched to a track, and if that 
track is enabled for recording. For more information about recording, see Chapter 65, 
“Recording.”

 � Loop: Toggles looped playback off and on. While looped playback is on, playback 
will loop at the end of the Timeline, and will also loop when you use the Play In to Out 
command, and will continue to loop automatically until you stop playback.

 � Automation Controls: This button exposes the automation toolbar. For more 
information about recording automation, see Chapter 69, “Automation Recording.”

Using JKL to Control Playback
The JKL keyboard shortcuts are common to many editing applications, and experienced editors 
know these to be some of the most useful controls for playback and editing there are. Here’s a 
list of the many different ways you can use these three keyboard shortcuts to play through clips 
and timelines as you work.

J Plays 100% backward.

K Stops playback.

L Plays 100% forward

Press J repeatedly Increases backward play speed each time you press J,  
for a range of fast-reverse speeds.

Press L repeatedly Increases forward play speed each time you press L,  
for a range of fast-forward speeds.

Shift-J Plays in fast reverse.

Shift-L Plays in fast forward.

K+J Plays backward at slow motion (with slow motion audio playback).

K+L Plays forward at slow motion  
(with pitch-corrected audio playback on OS X).

Pressing K while tapping J Moves the playhead back one frame.

Pressing K while tapping L Moves the playhead forward one frame.
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If you’re using Fairlight with the keyboard, then this will probably become one of the main ways 
you move the playhead around in Resolve.

Dragging the Playhead to Scrub
You can also drag the playhead left and right to scrub through the visible area of the timeline 
by clicking and dragging anywhere within the timeline ruler at the top of the timeline, directly 
below the toolbar. If you’re zoomed in at a reasonable level for editing, scrubbing the playhead 
using your pointer will result in smooth, tape-like slow and fast audio playback, giving you a 
great deal of precision while trimming audio.

Looping Playback
Two controls govern looping on the Fairlight page, similarly to how looping works on the Edit page.

 � Loop: Command-Forward Slash (/). Toggles looped playback off and on. While looped 
playback is on, playback initiated with any of the following commands will loop 
automatically until you stop playback.

 � Play In to Out: Option-Forward Slash (/). If you’ve marked a section of a clip or timeline 
with In and Out points, this command lets you preview how it will play.

Clip, Marker, and Track Navigation
The Arrow keys are used to navigate among clips, markers, and tracks in the Fairlight page, 
but they’re used very differently than they are in the other pages of Resolve. This section 
covers the basics.

Selecting Tracks
Which tracks are selected determine the behavior of the arrow keys.

 � In Selection mode: You can select tracks by clicking or Command-clicking (to select 
multiple tracks) anywhere in the background area or on the track number of the track 
headers. If you click-and-drag, you can use a bounding box to select multiple tracks.

 � In Range Selection mode: You can select tracks by clicking or Command-clicking 
anywhere either in the background area or on the track number of the track header, 
or in any unused area of the track itself in the timeline. If you click-and-drag, you can 
use a bounding box to select multiple tracks.

Left and Right Arrow Keys
In general, the Left and Right Arrow keys are used to move the playhead left and right in the 
timeline, navigating from clip to clip or marker to marker. How these keys function depends on 
whether or not one or more tracks is selected in the timeline.

 � If no tracks are selected: The Left and Right Arrow keys will jump the playhead from 
timeline marker to timeline marker. Clip markers will be ignored.

 � If one or more tracks are selected: The Left/Right Arrow keys will jump the playhead 
among clip In points, clip Out points, and timeline markers.



1138

Tr
an

sp
o

rt
 C

o
nt

ro
ls

, T
im

e
lin

e
 N

av
ig

at
io

n,
 a

nd
 M

ar
ke

rs
r 

P
ar

t 
8

 –
 6

4

Up and Down Arrow Keys
The Up and Down Arrow keys are used to move selected tracks up and down in the timeline. 
By changing which tracks are selected, you can alter which clip’s In and Out points are used to 
jump the playhead around the timeline.

If no tracks are selected, then nothing happens.

Zooming and Scrolling
The Fairlight page has several methods of zooming into and out of the timeline, and scrolling 
when you’re zoomed to the point where your edited sequence of clips extends past the left and 
right edge of the visible timeline.

Setting the Zoom Level of the Timeline
Depending on how you like to work, there are several methods of zooming into and out of 
the timeline.

 � Using the Vertical Zoom Slider: A pair of sliders at the right of the toolbar let you 
zoom vertically and horizontally. The first one lets you scroll vertically in order to see 
more detail in the height of your waveforms. If no tracks are selected, then zooming is 
centered on the top audio track in the timeline. If one or more tracks are selected, then 
zooming is centered on the topmost selected audio track.

 � Using the Vertical Zoom Slider: A pair of sliders at the right of the toolbar let you zoom 
vertically and horizontally. The second one lets you zoom horizontally in order to see 
more detail in the width of your waveforms. Zooming is always centered on the position 
of the playhead.

 � Pressing Command = and Command – (minus): Command-Equals (also referred to 
as Command-Plus) and Command-Minus let you zoom horizontally into the timeline. 
Zooming is always centered on the position of the playhead.

 � Using scroll controls of your pointing device to scroll horizontally: Holding the Option 
key down and using the scroll wheel (or scroll control) of your pointing device will zoom 
horizontally into the timeline. Zooming is centered on the position of the playhead. 

 � Using scroll controls of your pointing device to scroll vertically: Holding the Shift key 
down and using the scroll wheel (or scroll control) lets you zoom vertically in the 
timeline. In this case, if no tracks are selected, then zooming is centered on the 
top audio track in the timeline. If one or more tracks are selected, then zooming is 
centered on the topmost selected audio track.

 � Using the Fairlight panel’s Jog/Edit Wheel: If you have a Fairlight panel, you can hold 
the ZOOM button down while turning the Jog/Edit wheel to zoom into the timeline at 
the position of the playhead.

Scrolling Through the Timeline
However closely you’re zoomed into the timeline, if you’re zoomed enough so that clips extend 
past the visible area of the timeline, scroll bars appear below. If the playhead is offscreen, a 
small orange tic mark indicates its position relative to the entire timeline, which is represented 
by the total width of the scroll bar’s background.

If you drag the playhead, or otherwise use any of the transport controls or playback key 
shortcuts to move through the timeline, the contents of the timeline refresh every time the 
playhead hits the left or right edge of what’s visible.
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Using Flags
Flags are meant to mark an entire clip, and they also flag every other clip in the Timeline that 
shares the same Media Pool source clip, making this a handy way of quickly identifying which 
clips in a given timeline come from the same Media Pool source. Flags are visible in every page 
of DaVinci Resolve, making them an excellent method of tracking media from page to page.

The Flag and Marker buttons and pop-ups.

You can apply multiple flags to clips, with a variety of colors to choose from. In addition to 
flagging specific media files, flags can be useful for sorting by column in the Media Pool, as well 
as a variety of other operations.

Methods for flagging clips in the Fairlight page:

 � To flag a clip: Select one or more clips, and either click the Flag button to flag that 
clip with the current color, or click the Flag pop-up in the toolbar to choose a different 
color and then click the Flag button. In the Edit page, flags appear in the Timeline 
superimposed in the name bar of each clip.

 � To remove all flags from a clip: Select one or more clips with flags you want to remove, 
then click the Flag pop-up in the toolbar, and choose the top “Clear All” option. 

Using Markers
Markers are used to call attention to a particular frame within a specific clip. Markers can be 
individually colored, and can have customized name and note text. Whenever you enter text 
into a marker, that marker displays a small dot that indicates there’s more information inside of it. 
Once placed, markers snap to In and Out points, edit points, the playhead, and other markers 
whenever snapping is enabled, making it easy to use markers to “measure” edits and trims that 
you make in the Timeline. Markers are visible in every page of DaVinci Resolve, making them an 
excellent method of tracking frames in clips and specific moments in the timeline from 
page to page.

You can add markers to the timeline (in the timeline ruler) or to clips. The full procedures for 
placing and editing markers in the Fairlight page’s on-screen interface are identical to those for 
the Edit page, so for more information, see Chapter 20, “Marking and Finding Clips in the 
Timeline.” For now, here’s a summary.

Adding Markers to Clips
The following procedures describe how to add markers to clips in the timeline of the 
Media Page.
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To mark a clip in the Timeline, do one of the following: 

 � Select one or more clips you want to mark, then move the playhead to the frame of 
a selected clip in the Timeline, and click the Marker button in the toolbar (or press M) 
to place a marker at that frame, using the current color (if multiple overlapping clips are 
selected, you’ll add a marker to all clips). 

 � To place a marker during playback and immediately open the marker dialog to enter 
a name or note within it, select one or more clips you want to mark, play through 
the selection until you want to place a mark, then press Command-M. Playback 
pauses until you enter some text and close the marker dialog again, at which point 
playback continues.

 �  Select one or more clips you want to mark, and then click the Marker pop-up to choose 
a different color, and click the Marker button.

Adding Markers to Timelines
You can also place markers of any color into the Timeline ruler to denote specific times for 
future reference, or add notes about issues you want to keep track of. You should note that all 
markers placed on clips or in the Timeline also appear within the Mini-Timeline of the Color 
page, making it easy to place notes to reference particular audio cues that might be valuable 
when editing or grading.

To mark the Timeline itself, make sure all clips are deselected, and do one of the following: 

 � Click the Marker button (or press M) to place a marker of the currently selected color in 
the Timeline ruler. 

 � To place a marker during playback and immediately open the marker dialog to 
enter a name or note within it, select one or more clips you want to mark, then press 
Command-M. Playback pauses until you enter some text and close the marker dialog 
again, at which point playback continues.

 � Click the Marker pop-up to choose a different color, and click the Marker button. 

 � Right-click in the Timeline ruler and choose a marker color from the Add Marker 
submenu of the contextual menu.
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Chapter 65

Recording 
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Recording
It’s possible to record to one or more tracks on the Fairlight page, accommodating workflows as 
varied as editors recording scratch voice over or temp sound effects, recording engineers 
recording narration, ADR, or foley as part of the audio finishing process, music studios recording 
orchestras for the music score, or garage bands recording their latest magnum opus. While 
DaVinci Resolve is a comprehensive postproduction environment for cinema and video, the 
Fairlight page can be used for any audio recording application you might have, from 
books-on-tape to live music to feature films and television.

This chapter covers the somewhat brief basics of audio recording in the Fairlight page. Keep in 
mind that this is a work in progress, and that the comprehensive recording capabilities of earlier 
versions of Fairlight will be migrating into DaVinci Resolve as time passes.

Setting Up to Record 1143

Patching Inputs 1143

Arming Tracks 1144

Choosing Where to Record Audio Clips To 1144

Recording Using the Onscreen Controls 1144

Recording and Editing Multiple Takes Using Layering 1145
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Setting Up to Record
Depending on how your workstation is set up, it’s possible to simultaneously record to multiple 
tracks in the Fairlight page at once. How many tracks you can record to depend entirely on 
what hardware you have available. This section describes the process of recording to tracks in 
the Fairlight page.

Patching Inputs
Before you can record anything, you need to use the Patch Input/Output window to patch an 
available Audio Input to a track. If you’re computer has nothing else, the inputs of your 
workstation are available to connect whatever audio device is set up as the default audio input 
on your system to the track you want to record to.

To open the Patch Input/Output window, do one of the following:

 � Choose Fairlight > Patch Input/Output

 � Click the Input menu at the top of the channel strip of the track you want to record to, 
and choose Input…

The Input pop-up menu lets you open the Patch Input/
Output window with that track selected

To patch an audio source to an audio destination:

1 Make sure that the Audio Source menu is set to Audio Inputs, and the Audio 
Destination menu is set to Track Input.

2 On the right, click the audio input that you want to patch so it’s highlighted.

3 On the left, click the audio destination that you want to patch so it’s highlighted also, 
if it’s not already. In this simplified example, channel 1 of the Scarlett 2i2 is being 
connected to Audio 1, which is the only track in the timeline.

Selecting a source and a destination to patch
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4 Click the Patch button at the bottom of the window, and your recording setup will 
be patched. 

5 Continue steps 2 and 3 until you’ve patched all the inputs you want to record from 
to all of the tracks that you want to record onto. You can patch as many inputs to as 
many tracks as your system is set up to accommodate. In this example, there are two 
available audio sources, but there’s only a microphone connected to the first channel, 
so that’s the only one being connected.

6 When you’re finished, close the window.

Arming Tracks
To record on a track, it must be armed. You should note that it’s impossible to arm a track that 
hasn’t been patched first, so make sure you’ve patched the audio source you want to record 
from to the track you want to record to first. Then arming that track is as simple as clicking the R 
button in the track header controls, or in the channel strip for that track in the Mixer.

(Left) The arm button turned on in the track header,  
(Right) the arm button turned on in the channel strip

Once a track has been armed, you’re ready to record.

Choosing Where to Record Audio Clips To
The process of recording in the Fairlight page creates new clips and generates additional media 
on disk. You can specify the location on disk you want to save these recordings by opening the 
Capture and Playback panel of the Project Settings and using the Browse button, found 
underneath the “Save clips to” field, to choose a new location (a folder named “Capture” on 
your scratch disk is the default location).

To choose where the new clips that are created are placed in the Media Pool, simply open the 
Media Pool and select any bin in the Bin List, or create a new bin and select it if you want to put 
your recordings in their own location.

Recording Using the Onscreen Controls
You can record anywhere you want on the currently armed track or tracks by placing the 
playhead where you want recording to begin. In this way, you can record to specific areas of 
your program as you record voiceover, sound effects, foley, or other timed performances that 
need to fit into a particular region of the edit.

To begin recording:

1 Position the playhead where you want recording to begin.

2 Click the Record button in the Transport Controls. Recording immediately begins, and a 
red bar indicates where on the currently armed track material is being recorded.
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To stop recording, do one of the following:

 � Click the Stop button in the Transport Controls

 � Press the Space Bar

Recording and Editing Multiple 
Takes Using Layering
There are two ways you can record multiple takes. You can either record them one after the 
other, sequentially, and then edit them later. However, you also have the ability to record 
multiple takes to the same region of the timeline, one on top of another, while at the same time 
preserving every take using track layering.

In the following screenshot, multiple takes have been recorded over the same section of the 
timeline, including some partial takes to correct specific phrases in the voiceover being 
recorded. When you do this, the result looks like a series of cuts and overwritten clips, with the 
most recently recorded segments being the ones that play back over the previously 
recorded segments.

Overlapping recordings with Audio Track Layers turned off

However, if you choose View > Audio Track Layers, you’ll see that all your recordings have 
actually been preserved via a vertical stack of overlapping audio clips.

Overlapping recordings with Audio Track Layers turned on, showing layering within the same track

The layering of audio clips in DaVinci Resolve means that the topmost superimposed clips in a 
layered stack like this mutes the audio of overlapping clips that are lower in the stack.

Using layering, it’s easy to edit the best segments of the best takes, while preserving all other 
takes, simply by adding edits and rearranging clips in the stack so the best parts are on top.

For more information about audio layering, see Chapter 66, “Editing Basics in the 
Fairlight Page.”
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Chapter 66

Editing Basics 
in the 
Fairlight Page 
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Editing Basics in the Fairlight Page
You can use the Fairlight page to refine the editing of audio that was initially assembled in the 
Edit page, or you can use the Fairlight page to both record and edit audio programs from 
scratch. Because audio clips have properties that video clips do not, audio editing 
encompasses additional procedures that are not available in the Edit page. This chapter takes 
you through the fundamental steps of editing audio the Fairlight way.

Compatible Audio Formats 1148

Adding Audio Clips to the Timeline 1148

Overwriting vs. Layering Clips that Overlap 1148

Dragging Individual Audio Clips Into the Timeline 1148

Drag and Drop Editing of Several Clips Into the Timeline At Once 1148

Making Audio Clip Selections in the Timeline 1149

Clip Selection 1150

Track Selection 1151

Range Selection 1152

Automatic Selections In Selection Mode With Selected Tracks 1154

Automatic Selections In Range Selection Mode With Selected Tracks 1155

Locking Audio Tracks You Don’t Want to Change 1156

Splitting and Joining Clips 1156

Trimming Clips Without Rippling the Timeline 1157

Seven Point Editing 1157

Resizing the In and Out Points of a Clip 1157

Moving (Sliding) and Overwriting Clips 1158

Slipping 1158

Disabling and Re-Enabling Clips in the Timeline 1158

Deleting Audio Clips and Regions 1159

Cut, Copy, and Paste 1159

Audio Clip Layering 1162

Fades and Crossfades 1163

Using Fades 1163

Creating Crossfades With Overlapping Fades 1164

Using Crossfades From the Edit Page 1165

Finding Clips in the Media Pool  1166

Changing Clip Color in the Timeline 1166

Sample Editing 1166
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Compatible Audio Formats
DaVinci Resolve is compatible with WAVE, Broadcast WAVE, AIFF, MP3, AAC (M4A), CAF 
(macOS only), MTS and QuickTime containers using the AC3 audio format, and Enhanced AC-3 
(macOS and Windows) at sample rates including 32, 44.1, 48, 88.2, 96, and 192 kHz.

Adding Audio Clips to the Timeline
The Fairlight page offers a complete audio editing environment that lets you either record and 
assemble clips from scratch, or refine tracks full of audio clips that have been edited together in 
different ways. There are four ways of adding media to the timeline in the Fairlight page, 
depending on the type of work you do:

 � Recording new audio into one or more tracks (for more information, see Chapter 65, 
“Recording”)

 � By dragging and dropping new audio clips from the Media Pool into the 
Fairlight timeline

 � By editing audio clips into audio tracks on the Edit page

 � By importing a project with audio clips

However audio clips come to be in your timeline, the rest of this chapter covers the myriad 
methods available to edit and sweeten the contents.

Overwriting vs. Layering Clips that Overlap
When you add clips to the Timeline, what happens when you add a clip that overlaps another 
clip that’s already in the track you’re editing to depends on the Timeline > Layered Audio 
Editing setting. By default, with Layered Audio Editing turned off, overwriting one audio clip with 
another results in the overlapping part of the overwritten clip being non-destructively deleted 
from the Timeline by the incoming clip.

However, if you turn Layered Audio Editing on, then incoming clips do not overwrite overlapping 
clips in the Timeline; instead, they’re layered within that track, such that the incoming audio clip 
takes precedence over what was previously there, but overlapping audio segments that were 
previously in the Timeline are preserved, which can be seen when you choose View > Show 
Audio Track Layers.

In this way, you can choose whether you want to overwrite previously edited clips, or layer 
newly edited clips, as your needs require, regardless of whether or not Audio Track Layers are 
visible. Audio layering can be enabled in both the Edit and Fairlight pages.

For more information about audio layering, see the section later in this chapter.

Dragging Individual Audio Clips Into the Timeline
You can show the Media Pool in the Fairlight page, and edit audio clips into the timeline in their 
entirety by dragging and dropping individual clips onto whichever audio track you want them 
to appear.

Drag and Drop Editing of Several 
Clips Into the Timeline At Once
If you want to edit several clips into the Timeline at once by dragging them from the Media Pool, 
you’ll probably want to do a bit of preparation to make sure they’re edited in the right order.
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1 Change the sort order of the Media Pool’s browser area to put the clips into the order 
in which you want them to appear. In Thumbnail view you can use the Sort Order 
menu, but in List view you can click the header of any metadata column to sort by that 
column’s data.

Using the Sort Order menu to change the 
sort order of clips in the Media Pool

2 Use the Media Pool thumbnails, the Media Pool List view Filmstrip, or the Source 
Viewer to set In and Out points to define the part of each clip that you want to edit into 
the Timeline.

3 Select the the Media Pool clips you want to edit into the Timeline by dragging a 
bounding box, Command-dragging multiple bounding boxes over different sets 
of clips, by Shift-clicking a range of clips, or by Command-clicking individual non-
contiguous clips.

4 Drag any of the selected clips to the desired position in the Timeline to perform an 
overwrite edit.

The clip(s) you drag overwrite whatever other clips they overlap in the Timeline. 
Multiple clips dragged from the Media Pool will be edited in the order in which they’re 
sorted in the Media Pool, using each clip’s In and Out points.

Making Audio Clip Selections 
in the Timeline
Nearly every editing operation described in this chapter and others requires you to make a 
selection to define which clips will be affected. The two main editing modes in the Fairlight 
page are the Selection tool and the Range Selection tool. Which mode you choose determines 
how clips and clip segments are selected in the timeline in preparation for all manner of 
editorial operations.

The Selection and Range Selection 
tools seen in the Toolbar
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In selection mode, the process of making selections and working in the Fairlight page 
resembles that of the Edit page, although there are still key differences in terms of automatic 
behaviors that take place when you select tracks you want to work on.

To choose Selection Mode:

 � Click the Selection tool (the arrow) in the toolbar

 � Choose Trim > Selection Mode

 � Press A

In Range Selection mode, the process of making selections and selecting tracks works more 
similarly to traditional Fairlight editing systems. This unlocks more of the power of Fairlight 
editing, enabling the easier selection of tracks and partial selection of clips for purposes of fast 
audio editing. However, these operations are very different from similar operations found on the 
Edit page.

To choose Range Selection Mode:

 � Click the Range Selection tool (the crosshairs) in the toolbar

 � Choose Trim > Range Selection Mode 

 � Press R

Clip Selection
If you’re doing simple operations to entire clips, you can select clips in the timeline of the 
Fairlight page in most of the same ways you select them in the Edit page.

Methods of selecting clips:

 � Click any clip to select it

Click a clip to select it

 � Command-Clicking multiple clips to select them all at once

Command-clicking multiple track headers selects those tracks
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 � Click anywhere in the background of the timeline and drag a bounding box over 
multiple clips

Command-clicking multiple track headers selects those tracks

Track Selection
The timeline on the Fairlight page lets you select entire tracks, in order to simplify the process 
of choosing which clips on which tracks you want to be included in a particular operation, as 
well as to facilitate the automatic selection of clips that intersect the playhead for easy 
operation with keyboard shortcuts and the Fairlight Editing panel.

For example, if you want to copy clips on tracks A3 and A5, then you’ll want to start by doing 
one of the following things:

 � In Selection mode: You can select tracks by clicking or Command-clicking anywhere in 
the background area or on the track number of the track headers.

 � In Range Selection mode: You can select tracks by clicking or Command-clicking 
anywhere either in the background area or on the track number of the track header, or 
in any unused area of the track itself in the timeline.

Command-clicking multiple track headers selects those tracks

Were you to select tracks A3 and A5, then moving the playhead over the two clips you want to 
copy automatically selects them, and gets you ready for any operation you need to perform on 
both clips together, as seen in the previous screenshot. This is analogous to the use of the Auto 
Select controls on the Edit page, which define which clips and clip segments are automatically 
affected whenever you set In and Out points in the Timeline.
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Methods of selecting and de-selecting tracks in the Fairlight page timeline:

 � To select a single track: Click anywhere in the background or on the track number of 
that track’s header (not on a button). In Range Selection mode you can also click in any 
unused area of the track itself.

 � To de-select a single track: Click anywhere in the background or on the track number 
of a previously selected track’s header (not on a button). In Range Selection mode 
you can also click in any unused area of the track itself. If multiple tracks are selected, 
Command-clicking one will remove just that track from the selection.

 � To select multiple tracks: Command-click in the track header background of every 
track you want to select. In Range Selection mode you can also Command-click in any 
unused area of the tracks themselves. Command-clicking an already selected track will 
de-select it.

 � To select multiple continuous tracks: Click anywhere in the background or on the 
track number of a track header, and then drag a bounding box up or down over all 
other tracks you want to select. In Range Selection mode you can also drag a bounding 
box over any part of the tracks themselves, while also defining a range in which you 
want to work.

 � To move the selection to higher or lower tracks: Press the Up or Down Arrow keys 
to move the selection state to the next track higher (Up Arrow) or lower (Down Arrow). 
If multiple tracks are selected, then the multi-selection will be moved as a block; for 
example, selecting tracks A2 and A3 and then then pressing Down Arrow will result in 
tracks A3 and A4 being selected.

Range Selection
Pressing the R key enables Range Selection mode, in which you can create ranged selections 
with which to perform an operation to segments of one or more clips. Using the methods shown 
in this section, it’s easy to select specific segments of larger clips so that you can move, delete, 
cut, copy, or paste words, phrases, musical bars, or sounds that you want to edit somehow.

For a range to act as a selection, it must also encompass the selection of one or more tracks in 
addition to one or more clip segments on those tracks. Ranges can also be defined by setting 
In and Out points on the timeline. If you set In and Out points on the timeline without selecting 
one or more tracks, then the range you define doesn’t actually select anything; in this situation 
the range can be used for other purposes such as recording, but you’ll be unable to make any 
editorial changes to clips falling within this range.

Methods of selecting clips via clicking and dragging:

 � To select a single clip: Click any clip to select both it and the track it’s on, and define a 
range in the timeline that matches the duration of that clip.

Command-clicking multiple track headers selects those tracks
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 � To select multiple clips: Command-Clicking multiple clips to select them all at once 
defines a range in the timeline that matches the total overlapping duration of all clips 
in the selection, from the beginning of the first selected clip to the end of the last 
selected clip.

Range selection by Command-clicking multiple clips

 � To drag to select a range within a single clip: With the Range Selection tool selected, 
drag anywhere on top of a clip to drag a bounding box over whatever segment of that 
clip (or of one or more clips) to select both that clip segment and the track it appears 
on. This is a good way of selecting part of a recording you want to move or delete.

Ranged selection within a clip using a bounding box

 � To drag to select a range within multiple clips: Click-and-drag a bounding box over 
whatever segment of one or more clips you want to select to select both those clip 
segments and the tracks they appear on. Or, Command-click-and-drag anywhere on 
top of any clip to drag a bounding box over whatever region of clips and tracks you like.

Ranged selection across multiple clips using a bounding box
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In range selection mode, whenever you make a selection, the In and Out point fields update 
with the range that you’ve created. 

The range fields showing you the In 
and Out point values that define the 
current range

These ranges can be cleared if necessary.

Methods of clearing In and Out points to clear the current range:

 � Press Option-I to clear the current In point

 � Press Option-O to clear the current Out point

 � Press Option-X to clear both the In and Out points

Automatic Selections In Selection 
Mode With Selected Tracks
In Range Selection mode (press R), all clips that intersect the playhead on selected tracks of the 
timeline define a range in the timeline that matches the total overlapping duration of all clips in 
the selection, from the beginning of the first selected clip to the end of the last selected clip. 

Clips intersecting the playhead in selection mode are automatically selected with orange highlights

In this mode, the resulting selection allows whatever operation you perform to affect the 
entirety of whichever clips intersect the playhead. For example, pressing the Delete key will 
delete all selected clips in their entirety, and copying will copy the whole of each selected clip.

If you use the I (Mark In) and O (Mark Out) keys to define a range while in Selection mode, a 
range will be selected, suitable for various non-editing operations such as recording, but no 
clips or clips segments will be selected.
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Automatic Selections In Range 
Selection Mode With Selected Tracks
In Range Selection mode (press R), all clips that intersect the playhead on selected tracks of the 
timeline define a range in the timeline that matches the total overlapping duration of all clips in 
the selection, from the beginning of the first selected clip to the end of the last selected clip Z.

Clips intersecting the playhead in selection mode are automatically selected with orange highlights

In this mode, the resulting selection allows whatever operation you perform to affect the 
entirety of whichever clips intersect the playhead. For example, pressing the Delete key will 
delete all selected clips in their entirety, and copying will copy the whole of each selected clip.

However, in this mode you can use the I (Mark In) and O (Mark Out) keys to define a range, and 
all clip segments falling into this range on selected tracks will be selected.

To automatically select clip ranges on multiple selected tracks:

Use the I (Mark In) and O (Mark Out) keys to define a range in the Timeline, and all clip 
segments falling within this range on selected tracks will be selected

Selecting a range using In and Out points in the timeline
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Locking Audio Tracks You 
Don’t Want to Change
Another step you can take to prepare before performing any kind of editorial operation is to 
lock tracks with media that you don’t want to be affected by whatever it is you’re about to do. 
For example, if you have a complex set of music edits on track A3 that you don’t want to be 
affected by operations that will delete media that overlaps it, you can lock track A3 so those 
clips remain unaffected.

Locking an audio track

Clips on locked tracks cannot be moved, deleted, cut, or otherwise affected by editorial 
operations. Furthermore, parameters of locked clips cannot be edited in the Inspector. 
However, clips on locked tracks can be played back and mixed like any other audio  clips.

To toggle the lock or unlock state of audio tracks in the 
Fairlight page, do one of the following:

 � Click any track’s lock control to toggle lock on and off.

 � Click any track’s lock control and drag over the lock controls of other tracks in the 
timeline to quickly lock or unlock several adjacent clips.

Splitting and Joining Clips
In many situations you may find yourself splitting audio clips in order to separate multiple 
rolling takes.

To split one or more clips in either Selection or Range Selection mode:

1 Select each track that has a clip you want to split.

2 Move the playhead to intersect the clips you want to split at the frame where you want 
the split to happen.

3 Do one of the following:

a Choose Timeline > Split Clip or press Command-\ (backslash).

b Choose Timeline > Razor or press Command-B.

When you split a clip, a through edit appears to show that you currently have an edit with 
continuous timecode running from the outgoing to the incoming half. This is called a Through 
Edit, and is displayed with a dotted line running along its edge so you know that it’s special.

Clips cannot be joined as of the time of this writing.
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Trimming Clips Without 
Rippling the Timeline
Most basic adjustments in the Fairlight page only affect the selected clip or region of the 
timeline. Clips to the right of the adjusted area of the timeline are generally left alone so as not 
to inadvertently change sync when you don’t expect it. This section covers the most basic parts 
of the Fairlight page’s “seven point editing” paradigm.

Seven Point Editing
Each clip in the timeline has seven draggable handles that affect audio editing.

 � In point: The left edge of the clip, used to resize the beginning of the clip.

 � Out point: The right edge of the clip, used to resize the end of the clip.

 � Fade In handle: A handle at the upper left-hand corner of the clip that only appears 
when the mouse is positioned over that clip, used to fade the audio in, or as part of a 
crossfade between two audio clips. Fades can be reset (eliminated) by double-clicking 
the fade handle.

 � Fade In curve:  A handle at the center of the Fade In curve that only appears when the 
curve is exposed, used to adjust the power of the fade in. This handle can be dragged 
vertically to change the X-Level of the fade, and horizontally to change the X-Point of 
the fade. Fade curves can be reset by double-clicking the curve handle.

 � Fade Out handle: A handle at the upper right-hand corner of the clip that only appears 
when the mouse is positioned over that clip, used to fade the audio out, or as part of a 
crossfade between two audio clips. Fades can be reset (eliminated) by double-clicking 
the fade handle.

 � Fade Out curve: A handle at the center of the Fade Out curve that only appears when 
the curve is exposed, used to adjust the power of the fade out. This handle can be 
dragged vertically to change the X-Level of the fade, and horizontally to change the 
X-Point of the fade. Fade curves can be reset by double-clicking the curve handle.

 � Level: Considered an editorial characteristic, the level of any given audio clip can be 
adjusted via a level overlay running across each clip. The level of any clip can be reset 
to the default 0.0 dB by double-clicking the level overlay.

Resizing the In and Out Points of a Clip
Trimming the Head or Tail of a clip in the Fairlight page means to resize the In or Out point of 
that clip, making it shorter or longer accordingly.

To resize the beginning or end of a clip:

 � To shorten or lengthen clips: Move the pointer over the beginning or end of a clip, 
and when it turns into the Resize cursor, drag the In or Out point to the left or right 
to change the clip’s length. As you drag the In or Out point of an audio clip in the 
Fairlight page, an overlay appears showing the waveform of all available media at the 
head (if you’re dragging the In point) or tail (if you’re dragging the out point) of the clip 
you’re resizing.

The overlay seen when resizing the In point of an audio clip in the Fairlight page
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To quickly resize the beginning or end of a clip to the very beginning or end of available media:

 � Double-click the In point of the clip to move the In point to the very beginning of that 
clip’s media.

 � Double-click the Out point of the clip to move the Out point to the very end of that 
clip’s media.

If you resize a clip’s In or Out point to overlap one or more neighboring clips in the timeline, the 
overlapping parts of the neighboring clips will be overwritten by the clip you’ve resized.

Moving (Sliding) and Overwriting Clips
Formerly called Slipping in previous versions of Fairlight, sliding refers to moving a clip to the 
left or right in the Timeline, changing the timing of that clip’s position in the edit.

To move or slide clips in the timeline, do one of the following:

 � To move one or more selected clips in the Timeline: Drag any clip in the Timeline to 
any other position. If you drag a clip to overlap another clip, the clip you’re dragging 
overwrites the clip you’re moving it over. 

 � To nudge one or more selected clips in the Timeline using the keyboard: Press the 
Comma key (nudge 1 frame left) or Period key (nudge 1 frame right) to roll the selected 
edit to the left or right. Shift-Comma and Shift-Period nudges by 5 frames.

 � To move one or more selected clips up or down to other tracks at the same time: 
Hold the Shift key down while dragging clips up or down in the Timeline to lock their 
position in time while moving them to other tracks. Or, you can hold the Option key 
down and press Up or Down Arrow.

Slipping
Formerly called Resyncing, Slipping an audio clip keeps that clip in the same place in the 
Timeline while changing the range of media that appears in that spot. Slip edits do not change 
the duration of the overall Timeline, and they don’t move the clip’s position relative to the other 
clips in the timeline. Slipping simply changes the range of media that clip represents.

Slipping is not available at the time of this writing.

Disabling and Re-Enabling 
Clips in the Timeline
Sometimes there’s one or more audio clips in the timeline that you don’t want to play along with 
the rest of the edited sequence, but you don’t want to remove from the timeline either, in case 
you change your mind later. For this reason, it’s possible to Disable clips, effectively turning 
them off without removing them. Previous versions of Fairlight referred to this operation as 
Mute clip.

Disabled clips appear dimmed in the timeline. They don’t play back, they’re not rendered, and 
they’re not output to video. However, their position is preserved in the timeline, so you can 
always re-enable them at a later time if you change your mind and decide you want 
to use them.
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To disable or re-enable one or more selected clips:

 � Right-click part of the selection and choose Enable Clip from the contextual menu

 � Choose Clip > Enable Clip

 � Press D

Deleting Audio Clips and Regions
You can delete any clip(s) or clip region(s) that you can select, in either Selection or Ranged 
Selection modes by pressing the Delete or Forward Delete keys, or by right-clicking a clip and 
choosing Delete Selected from the contextual menu. In the Fairlight page, deleting anything 
leaves a gap. You can not ripple delete anything.

Cut, Copy, and Paste
The Fairlight page has a unique copy and paste methodology that takes advantage of the 
“ghost” overlays that are used for the waveforms of selected audio clips. This method makes it 
easy to copy and paste clips using keyboard shortcuts and the JKL keys.

To cut or copy and paste either all or part of a clip:

1 If you’re cutting or copying a while clip, then choose either the Selection (press A) or 
Range Selection (press T) mode. If you’re cutting or copying part of a clip, then make 
sure you’re in Range Selection mode (press T).

2 To use the playhead to make a clip selection, select the track that contains the clip you 
want to copy or cut. If one or more tracks are already selected, you can use the Up and 
Down Arrow keys to move the track selection state up or down to the tracks with the 
clip you want to cut or copy.

Selecting the track with a clip you need to cut
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3 Do one of the following:

a To cut or copy a whole clip, move the playhead so that it intersects the clip you 
want to cut or copy. If the playhead intersects a clip on a selected track, that clip 
should become selected. You should note that even if you use the mouse to select 
a clip without selecting a track first, you should still move the playhead to intersect 
the clip you’re copying or pasting, as this sets up an important reference point for 
the operation.

b To cut or copy segment of a clip, move the playhead so that it intersects the clip 
you want to cut or copy. If the playhead intersects a clip on a selected track, that 
clip should become selected. Then, using JKL and the I (In) and O (Out) keys, mark 
a range in the timeline that includes the segment of the clip you want. That 
segment should appear highlighted as a result.

Cutting or copying a segment of a clip using In and Out points

4 Making sure the playhead is over the section of the waveform that you want to use as 
the frame to move  the clip by, press Command-X to cut or Command-C to copy that 
clip (you can also right-click a clip and choose Copy or Cut). That clip will immediately 
become highlighted.

Cutting or copying a clip at the position of the playhead
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5 At this point, there are two things you can do to position the cut or copied clip to the 
position in the timeline at which you want to paste it:

a Moving the playhead will now also move the clip you cut or copied, shown as a 
ghost clip with waveform that’s “attached” to the playhead at the frame you chose. 
Whether you drag the playhead with your mouse or use JKL to move the playhead 
through the timeline, the cut or copied clip will move along with it, so that moving 
the playhead repositions the cut or copied clip on that track.

b If you want to move the cut or copied clip to another track, use the Up or Down 
Arrow keys to change the selected track; the ghost clip will move along with 
change in track selection.

Positioning the cut or copied clip before you paste it

This way, you can use the playhead to align the ghost waveform with other audio clips 
surrounding it in preparation for pasting it.

6 When the clip is positioned where you want it, press Command-V to paste the clip at 
the position you’ve chosen (you can also right-click a track and choose Paste from the 
contextual menu). The clip becomes solid, and you’re finished.

The pasted clip

Using this method of cutting and pasting makes it quick to cut or copy clips using only 
keyboard commands, with the clip’s ghost overlay making it easy to precisely align the 
clip you’re pasting to fit exactly where you need it to, perfectly in sync.
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Audio Clip Layering
Audio layering is a special audio editing mode that lets you superimpose multiple audio clips in 
the same track, with audio clips edited into the top layers muting overlapping sections of audio 
clips appearing on lower layers. With audio layering enabled, superimposed audio clips are 
treated similarly to superimposed video clips that have opacity set to 100%, with clips on top 
obscuring (or muting) clips underneath. 

An example of multiple audio performances editing using layers, where the 
top layer mute overlapping sections of audio clips in lower layers

Audio layering is incredibly useful for any situation where you’re combining segments of 
multiple takes together to create a single voiceover, audio vocal track, or dramatic performance, 
as you can choose which segments to use via their superimposed position in the stack of clips 
appearing in that track, while at the same time you’re preserving the other takes underneath in 
case you might want them later.

To enable audio layering:

Choose Timeline > Layered Audio Editing so that a check mark appears by the command. All 
overlapping audio will be layered in stead of overwritten from that point forward.

To view audio layering:

1 Choose View > Show Audio Track Layers to reveal track layers for each audio track 
(and each lane within a given audio track) in the timeline. When layering is on, space 
appears at the top of each track in the timeline which provides a region into which you 
can edit layered audio clips.

2 To edit an audio clip or segment as a layer within a particular audio track, drag it from 
elsewhere in the timeline or from the Media Pool, and drop it into the empty area above 
whatever audio is already in that track.

Dragging an audio clip to become layered above another clip

TIP: Track Layering can be used on the Edit page as well.
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3 Edit the different superimposed layers of audio such that the segments of each 
take that you like are on top. Only the topmost clip segments will be audible. Audio 
segments that overlap underneath are silent. To put another layer on top, drag it from 
its current position to the empty area at the top of the track.

Dragging a bottom audio layer to appear on top

4 When you’re finished editing clips in track layers, choose View > Show Audio Track 
Layers again to hide the individual layers, so that only the topmost clips appear as a flat 
sequence in each track and lane.

Hiding layers makes all audio layers appear on a single track, as if the top clips are 
overwriting what’s underneath, except the muted material underneath is preserved

Fades and Crossfades
Part of audio editing in the Fairlight page is the use of fades and crossfades. This section shows 
you how to create these effects for smoothly segueing from one audio clip to another.

Using Fades
Like the Edit page, each audio clip has fader handles that appear at the upper right and left 
corners of a clip you’re hovering the pointer over.

Fader handles appear when you hover the pointer over a clip

Pulling these handles out creates a fade effect with a duration equal to the length you 
extended the handle.
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Creating a fade effect by pulling out one of the fader handles

Once you’ve created a fade effect, you can adjust the curve of the fade by dragging 
the handle that appears right on top of the fader curve. Dragging the handle up and 
down affects the angle of the curve, and dragging the handle left and right affects the 
shape of the curve. In this way, you can create all manner of fade effects.

Adjusting the curve of the fade

Creating Crossfades With Overlapping Fades
While a fade gradually fades a single track of audio up, a crossfade fades one clip up at the 
same time as fading another clip down, for the aural equivalent of a cross dissolve. There are 
currently two ways of creating a crossfade in the Fairlight page. Both depend on clip layering to 
allow you to have overlapping fades over overlapping clips.

To create a crossfade by overlapping two clips together:

1 Add a fade out to the end of one clip, and a fade in to the beginning of another clip.

Adding fades to adjacent clips

2 Drag the first clip to overlap the second clip by the length of the fade you’ve created.
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Dragging the clips to overlap, the overlapping 
parts will be preserved via Clip Layering

3 Drop the clip, the overlapping fades will both be preserved thanks to clip layering, and 
a crossfade will appear in the timeline.

The resulting crossfade

To create a crossfade over two clips that are already layered:

Drag a fader handle at the beginning or end of a clip that’s layered, and a crossfade will 
automatically appear.

Creating a crossfade by adjusting the 
fader handle of a layered clip

Using Crossfades From the Edit Page
You can also add crossfades in the Edit page, but they appear in the Fairlight page as 
transitions in the Edit page style. 

The resulting crossfade Finding Clips in the Media Pool
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Finding Clips in the Media Pool 
You can right-click any clip in the Timeline and choose Find in Media Pool to automatically 
select that clip in the Media Pool, for instances where you might want to edit another copy of 
that clip somewhere else in the Timeline, or re-edit another segment from that clip into the 
same area.

Changing Clip Color in the Timeline
You can right-click one or more clips in the Timeline to change the clip color, to be 
more organized.

Sample Editing
You can zoom quite far into audio clips on the Fairlight page timeline, until you see the 
individual samples that comprise the audio waveform of each clip. Samples are represented by 
control points once you’ve zoomed in far enough. 

When you zoom in far enough, you can see the individual samples 
of an audio clip as control points

You can non-destructively edit these control points to eliminate clicks and pops, and to effect 
other fixes to problem audio clips. 

Methods of editing audio samples:

 � To see the editable audio samples: Zoom all the way into an audio clip until you see 
the sample control points, using either Command-Plus or Command-Minus, the scroll 
wheel of your pointing device, or by holding down the ZOOM button of your Fairlight 
Editing Panel and turning the JOG/EDITING wheel.

 � To edit a single audio sample: Click and drag that audio sample up or down to change 
its height.

 � To edit a section of samples: Click and drag horizontally left or right across the 
samples you want to edit to “redraw” the waveform any way you’d like.

Black points show the previous levels when samples have been edited in a clip

Sample Editing can be undone, just like any other editing procedure, as the edited sample 
points are stored non-destructively within the Resolve project.
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Chapter 67

Clip Levels, 
Crossfades, 
Equalization, 
and Gating 
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Clip Levels, Crossfades, 
Equalization, and Gating
Each audio clip in a track has individual settings that can be adjusted that are specific to that 
clip. This makes it easy to adjust the levels of several clips to match one another, while 
reserving the track level for your overall mix. This chapter describes how to use these clip-
specific controls.

Audio Settings in the Inspector 1169

Adjusting Audio in the Inspector 1169

Adjusting Audio in the Timeline 1170

How to Add and Adjust Audio Keyframes 1170

Clip EQ 1171

Master EQ Controls 1171

Graphical EQ controls 1171

Bands 1 and 4 1172

Bands 2-3 1172
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Audio Settings in the Inspector
Each clip has some simple audio-related parameters in the Audio panel of the Inspector.

 � Volume: Each clip has a single volume control, that corresponds to the volume overlay 
over each audio clip.

 � Equalizer: Each clip also has a four-band EQ, complete with low-pass, high-pass, and 
parametric settings for fine tuning and problem-solving audio issues at the clip level.

Additionally, when you apply other audio plug-ins from the Audio FX panel of the Effects 
Library, additional parameters and controls are exposed (covered towards the end of 
this chapter).

Setting Clip Levels
Each audio clip, or audio item in the case of audio clips with linked audio on multiple tracks, has 
its own Volume level. This means that audio clips with multiple channels share a common 
Volume setting. There are several ways you can adjust these levels simply.

Adjusting Audio in the Inspector
Each clip has individual Level parameters that are accessible in the Audio panel of the Inspector 
when one or more audio clips are selected.

The Volume and Pan parameters available for 
audio clips in the Inspector

Selecting an audio clip in the Timeline and adjusting its Volume or Pan only alters that clip, 
which lets you set basic levels for individual clips in your program. The Volume control affects 
every channel within that clip simultaneously. 

If you select multiple clips in the Timeline, then adjusting the Volume or Pan sliders or virtual 
sliders for all of them simultaneously will make a relative adjustment to all of the clips, 
preserving their offsets from one another. If you want to set all clips to the same level, then 
making a numeric adjustment will set all selected clips to the same absolute level.
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Adjusting Audio in the Timeline
Each clip (or item) of audio in the Timeline has a Volume overlay that lets you set that clip’s level 
by simply dragging it up or down with the pointer. This overlay corresponds to the Volume 
parameter in the Inspector.

Dragging a Volume overlay to adjust the clip level

Additionally, you can click any clip’s Audio Curve Editor button, at the bottom right-hand corner 
of each audio clip, to open an audio-specific Curve Editor with which you can keyframe not just 
Volume, but Pan, and the parameters of any audio filters you might have applied to that clip.

How to Add and Adjust Audio Keyframes
Mixing audio by adding and adjusting individual keyframes can be a fast and effective way of 
balancing clip levels with one another and of fixing clip-specific dynamic level problems. When 
manually editing any audio parameter curve, you can use the following procedures.

Methods of adjusting different audio curves using the pointer:

 � To adjust any curve segment: Position the pointer between any two keyframes, 
directly on top of the curve segment you want to raise or lower, and when the move 
cursor is displayed, click and drag up to raise the level, or down to reduce the level.

 � To add keyframes to the level curve: Hold the Option key down and click the curve 
to place a keyframe at that frame. You must add at least two keyframes to create an 
automated change in volume.

 � To adjust any keyframe: Move the pointer over a keyframe so that the four-way 
cursor appears, and then click and drag in the intended direction of adjustment, 
either vertically to change the volume of the clip at that frame, or horizontally to move 
the keyframe to a different point in time. Once you start dragging a keyframe into 
a particular direction, keyframe movement is constrained in that direction until you 
release that keyframe.

NOTE: At the time of this writing, keyframes cannot be deleted, and there are no 
bezier curves for clip keyframes.
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Clip EQ
Each audio clip in the timeline has a four band equalizer that has both graphical and numeric 
controls for boosting or attenuating different ranges of frequencies within that clip, before it 
even gets to the EQ built into the mixer. Each band has controls for the filter type (Bell, Lo-Shelf, 
Hi-Shelf, Notch), Frequency, Gain, and Q-factor (sharpness of the band), with the available 
controls for each band of EQ changing depending on the filter type.

When a channel strip’s EQ is enabled, the EQ button displays the equalization curve that’s 
being applied. This indicator cannot be adjusted, you must open the EQ window to make 
modifications.

The channel strip’s EQ indicator, (Left) EQ is at detente, (Right) EQ is adjusted

Master EQ Controls
The Equalizer window has the following overall controls:

 � Enable button: Turns the overall EQ effect off and on, without resetting the controls.

 � Reset button: Resets all controls of the EQ window to their defaults.

Graphical EQ controls
A graph at the top shows a curve with handles that correspond to each of the enabled 
EQ bands listed below. You can drag any numbered handle to boost or attenuate the range of 
frequencies governed by that band, using whatever type of equalization that band has 
been set to.

Dragging the numbered handles on this graph in turn modifies the parameters of the 
corresponding band, and changing each bands parameters will also alter the EQ graph, which 
serves the additional purpose of providing a graphical representation of the equalization being 
applied to that track.
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The EQ graph with user-draggable handles

Bands 1 and 4
The outer two sets of band controls let you make high-pass and low-pass adjustments, 
if necessary.

 � Band enable button: Turns each band of EQ on and off.

 � Band filter type: Bands 1 and 6 can be switched among four specific filtering options 
for processing the lowest or highest frequencies in the signal. These include (from top 
to bottom) Hi-Shelf, Hi-Pass, Lo-Pass, and Lo-Shelf.

 � Freq: Adjusts the center frequency of the EQ adjustment

 � Gain: Adjusts the amount by which the affected frequencies are affected. Negative 
values attenuate those frequencies, while positive values boost those frequencies.

Bands 2-3
The middle two sets of band controls let you make a wide variety of equalization adjustments.

 � Band enable button: Turns each band of EQ on and off.

 � Band filter type: Bands 2–5 can be switched among four different filtering options 
(from top to bottom) Lo-Shelf, Bell, Notch, and Hi-Shelf

 � Frequency: Adjusts the center frequency of the EQ adjustment

 � Gain: Adjusts the amount by which the affected frequencies are affected. Negative 
values attenuate those frequencies, while positive values boost those frequencies.

 � Q Factor: Adjusts the width of affected frequencies. Lower values include a wider 
range of frequencies, higher values include a narrower range of frequencies
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Chapter 68

Mixing in the 
Fairlight Page
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Mixing in the Fairlight Page
The mixer is the spider at the center of the web that is the Fairlight page, and provides the 
primary tools you’ll use to mix the various audio tracks of your program in to a harmonious 
whole using EQ, Dynamics, Panning, level control, and VST and Audio Units audio effects of all 
kinds, all with full automation, to hone your sound and balance each track’s elements with the 
others. This chapter focuses on explaining the various functions of the mixer so you can 
harness its power for yourself.

Introduction to Mixing 1175

The Mixer 1175

Tracks and Buses 1176

Customizing the Mixer Controls 1177

Showing and Hiding Channel Strips Using the Index 1178

Selecting Channel Strips and Tracks 1178

Track Organization 1179

Input 1179

Effects 1180

Insert 1180

EQ 1180

Master EQ Controls 1181

Graphical EQ controls 1182

Bands 1 and 6 1182

Bands 2-5 1183

Dynamics 1183

Master Dynamics Controls 1184

Expander/Gate 1185

Compressor 1185

Limiter 1186

Aux 1186

Pan 1187

Bus Assignment Buttons 1188

Arm, Solo, and Mute Buttons 1189

Fader Controls 1189
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Introduction to Mixing
This chapter describes the use of the mixer to adjust the levels and fine-tune the audio of each 
track in the timeline. It’s focused on the function of the channel strip controls, with the following 
exceptions:

For more information about Busing, see Chapter 63, “Setting Up Tracks, Buses, and Patching”

For more information about recording audio, see Chapter 65, “Recording”

For more information about recording automation, see Chapter 69, “Automation Recordding”

The Mixer
The Audio Mixer provides a set of graphical controls you can use to assign track channels to 
output channels, adjust EQ and Dynamics, set levels and record automation, pan stereo and 
surround audio, and mute and solo tracks. At its most basic, each audio track in your timeline 
corresponds to an individual channel strip in the Mixer, and by default there’s a single Main bus 
labeled M1 that combines all these tracks into an overall mix.

The Audio Mixer, with channel strips corresponding to the tracks in the Timeline
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Tracks and Buses
Once you start creating buses, the Audio Mixer exposes two sets of channel strips. The 
left-most set of channel strips correspond to the audio tracks in the Timeline, while the right-
most set of channel strips expose sets of controls for each Main, Sub (submix), and Aux 
(auxiliary) bus that you’ve created. 

The Audio Mixer is divided into two sections, one for tracks (at left) 
and one for buses (at right)

If you have more tracks and buses then can be displayed all at once given the width of your 
computer display, then each half of the mixer has independent scroll bars so you can choose 
which tracks and which buses you want to see next to one another.

Each audio track’s channel strip has a set of Main and Sub bus buttons that let you assign the 
audio output by that channel strip to a Sub (typically used to combine different subsets of tracks 
into submixes) or to a Main (typically used to output or render overall mixes). Each Sub and 
Aux’s channel strip has a set of Main buttons so that different combinations of Subs can be 
assigned to each Main. Main channel strips have no buttons because, from a busing 
perspective, they’re the final output.

Main and Submix buttons let you assign tracks to buses, and buses to other buses

Third Party Mixing Control Panel Support

DaVinci Resolve supports HUI- and MCU-compatible third party mixing control panels 
with up to 8 faders, such as the Mackie MCU Pro Control Surface, connected via USB 
MIDI, and selectable in the Control Panels panel of the Resolve System Preferences.

Support at the time of this writing includes Mute, Solo, double-press for track 
selection, Fader control and Level display, Rotary control, Rotary Value display, and 
Rotary touch, Record, Track Name display, Channel and Bank scroll, double-press 
Bank Left for Home, double-press Bank Right for Masters, Transport controls including 
REW, FF, Play, double-press Play for play again, Stop, double-press Stop for Home, 
Marker, Marker+Stop to set Home, Marker+FF/REW to Jump, and Jog control. 
Additional controls include Master Solo clear/restore, Undo, Undo+Option to Redo, 
arrows, zoom horizontal and vertical, Automation On/Off with Write/Trim/Touch/Latch 
switches, Nudge, Cut, Copy, and Paste. Monitoring controls include Level control, Dim, 
Mute, and Alt Speaker.

For more information on third party mixing control panel support, see the Blackmagic 
Support site on the web at https://www.blackmagicdesign.com/support/family/
davinci-resolve-and-fusion.

https://www.blackmagicdesign.com/support/family/davinci-resolve-and-fusion
https://www.blackmagicdesign.com/support/family/davinci-resolve-and-fusion
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Customizing the Mixer Controls
The Option menu at the upper right-hand corner of the Mixer provides a number of different 
options for customizing the look of the Mixer, as well as which controls are shown or hidden.

First, you have the options of showing the Full Track Mixer or the Small Track Mixer. While the 
Full Track Mixer provides more room for buttons and controls that are large enough you don’t 
have to squint to see them, the Small Track Mixer lets you have many more channel strips 
onscreen at one time, for those times where you’re doing incredibly ambitious mixes.

The Small Track Mixer view

Second, there’s an option to Show Labels, which are the control names listed in a column to the 
left of the mixer channel strip area. If you’re first getting started, these Labels are useful, but 
once you’ve gotten used to the layout of the Mixer, hiding these will give you a bit more room to 
work with for another channel strip or two.
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Third, there’s a set of options that let you toggle the visibility of specific channel strip controls, 
so you can hide controls you know you’re not going to be using, or that you’ve used but no 
longer need to adjust or want to protect from accidental adjustment by a wandering 
mouse or pen.

Showing and Hiding Channel Strips Using the Index
You can use the Tracks panel of the Index to hide tracks you don’t need to work on in order to 
create more room for tracks you need to see. To quickly show or hid a number of tracks, you 
can click and drag over those tracks to reverse the visibility of every track you drag over.

The Tracks panel of the Index hiding tracks 1–4 on both the 
Timeline and the Mixer

Selecting Channel Strips and Tracks
When you select a track in the Timeline, you also select that track’s accompanying channel 
strip, and vice versa. It’s possible to select multiple tracks in the Timeline and thereby select 
multiple channel strips, but you can also Command-click to select multiple channel strips in 
order to select multiple tracks. 

Selecting multiple channel strips results in the selection of multiple tracks
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Track Organization
Each channel strip has three organizational properties that let you keep track of which channel 
strip is responsible for which part of the mix.

 � Track Color: Each track can be differently color-coded, to help you keep organized. 
These colors appear in the timeline track header, the mixer, and the meters to help you 
keep track of which track corresponds to which channel strip and meter.

 � Track Number: The number of the timeline audio track corresponding to each channel 
strip appears here.

The track color and track number appear at the top of each channel strip

 � Track Name: This mirrors the track name found in the header controls of the timeline. If 
you customize an audio track’s name in the timeline, that name appears here.

Each track’s name appears between the assignment buttons and the arm/solo/mute buttons

Input
A pop-up menu that lets you patch inputs, patch buses, and configure the input settings 
of audio signals routed through Blackmagic hardware interfaces.

The Input pop-up menu provides shortcuts for patching different 
buses using the Patch Input/Output window

For more information on using the options of the insert menu, see Chapter 63, “Setting Up 
Tracks, Buses, and Patching.”
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Effects
When you apply VST or Audio Unit effects to a track from the Effects Library, those effects 
appear here. Clicking the Plus button opens a pop-up menu with which you can apply any VST 
or AU effects installed on your machine to that track.

Moving the pointer over the plus to add effects

Hovering the mouse over any listed effect reveals controls for enabling/disabling each effect, 
opening an effect’s custom controls, and deleting that effect.

Moving the pointer over an effect 
reveals controls for that effect

For more information on using audio effects, see Chapter 70, “Audio Effects.”

Insert
Enables the routing of effects from Blackmagic audio interface hardware to outboard effects 
boxes and back again. This button can be toggled to enable/disable such routing.

EQ
Double-clicking exposes a four band parametric equalizer with additional Hi and Lo Pass filters, 
that has both graphical and numeric controls for boosting or attenuating different ranges of 
frequencies of audio on each track. You can select from among four types of EQ filtering from 
the Equalizer Type pop-up menu, with options for Earth (the default), Air, Ice, and Fire. Each 
band has controls for the filter type (Bell, Lo-Shelf, Hi-Shelf, Notch), Frequency, Gain, and 
Q-factor (sharpness of the band), with the available controls for each band of EQ changing 
depending on the filter type.
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The channel strip EQ window

When a channel strip’s EQ is enabled, the EQ button displays the equalization curve that’s 
being applied. This indicator cannot be adjusted, you must open the EQ window to make 
modifications.

The channel strip’s EQ indicator, (Left) EQ is adjusted, (Right) EQ is detente

Master EQ Controls
The Equalizer window has the following overall controls:

 � Enable button: Turns the overall EQ effect off and on, without resetting the controls.

 � Reset button: Resets all controls of the EQ window to their defaults.

 � Equalizer Type: Changes the EQ control functionality to emulate different EQ 
characteristics from “classic” mixing consoles. There are four options:

Earth: (Default) Native Fairlight controls

Air: Emulates the SSL 4K

Ice: Emulates the Neve V

Fire: Emulates the Focusrite

 � Gain fader: A post-EQ level control that lets you boost or attenuate the signal to 
compensate for the EQ adjustment you’re making raising or lowering the level.
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Graphical EQ controls
A graph at the top shows a curve with handles that correspond to each of the enabled EQ 
bands listed below. You can drag any numbered handle to boost or attenuate the range of 
frequencies governed by that band, using whatever type of equalization that band has 
been set to.

The EQ graph with user-draggable handles

Dragging the numbered handles on this graph in turn modifies the parameters of the 
corresponding band, and changing each bands parameters will also alter the EQ graph, which 
serves the additional purpose of providing a graphical representation of the equalization being 
applied to that track.

Bands 1 and 6
The outer two sets of band controls let you make high-pass and low-pass adjustments, if 
necessary. They’re off by default.

The Band 1 and 6 controls

 � Band enable button: Turns each band of EQ on and off.

 � Band filter type: Bands 1 and 6 can be switched among four specific filtering options 
for processing the lowest or highest frequencies in the signal. These include (from top 
to bottom) Hi-Shelf, Hi-Pass, Lo-Pass, and Lo-Shelf.

 � Frequency: Adjusts the center frequency of the EQ adjustment

 � Gain: Adjusts the amount by which the affected frequencies are affected. Negative 
values attenuate those frequencies, while positive values boost those frequencies.
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Bands 2-5
The middle four sets of band controls let you make a wide variety of equalization adjustments. 
They’re on by default, to make it easy to begin making adjustments.

The Band 1 and 6 controls

 � Band enable button: Turns each band of EQ on and off.

 � Band filter type: Bands 2–5 can be switched among four different filtering options 
(from top to bottom) Lo-Shelf, Bell, Notch, and Hi-Shelf

 � Frequency: Adjusts the center frequency of the EQ adjustment

 � Gain: Adjusts the amount by which the affected frequencies are affected. Negative 
values attenuate those frequencies, while positive values boost those frequencies.

 � Q Factor: Adjusts the width of affected frequencies. Lower values include a wider 
range of frequencies, higher values include a narrower range of frequencies

Dynamics
Double-clicking exposes a set of dynamics controls with three sets of controls corresponding to 
an Expander or Gate, a Compressor, and a Limiter that can be used separately or in concert to 
manage the dynamics of the audio on that track.

The channel strip Dynamics control window
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When you enable whatever combination of dynamics controls you need for that track, the 
dynamics graph updates with curves that show you how the signal is being affected by the 
Expander or Gate, Compressor, and/or Limiter settings that are being applied.

The dynamics graph shows how the signal 
is being affected by the current settings

With these dynamics enabled, the Dynamics button on the channel strip displays these curves, 
so you know what’s happening to that channel. This indicator cannot be adjusted, you must 
open the Dynamics window to make modifications.

The channel strip’s Dynamics indicator, (Left) 
Dynamics at detente, (Right) Dynamics adjusted

Master Dynamics Controls
The Dynamics window contains the following overall controls at the top of the window:

 � Reset button: Resets all controls of the EQ window to their defaults.

 � Side Chain: Enabling this checkbox sets the compressor to use a separate input to 
control the amount of compression that’s applied. The effect is that when there’s a loud 
level in the controlling input, the level of the track is reduced.

 � Link Channels: When disabled, each channel is compressed independently. When 
enabled, all channels are compressed based on the same controlling input used for 
Side Chain compression.

 � Make Up fader: A post-Dynamics level control that lets you boost the signal to 
compensate for dynamics settings that have lowered the level.
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Expander/Gate
The first of three sets of dynamics parameters can be switched between Expansion and Gating. 
Expansion emphasizes differences in volume by lowering the level of soft parts of the signal 
relative to the level of louder parts. Can be used to minimize noise while increasing the dynamic 
range of a signal. Gating reduces the level or even silences parts of a signal that fall below a 
certain level in order to reduce or eliminate noise in quiet parts of a recording.

 � Expander: A button that lets you enable these controls and switch them to perform 
Expansion.

Threshold: Sets the signal level below which gain reduction occurs. Defaults to -35dB. 
The range is from -50 to 0dB.

Range: Unused for expansion.

Ratio: Sets the gain reduction ratio (input to output) that’s applied to signals which fall 
below the threshold level. Defaults to 1:1.1. The range is 1.0:1 to 10:1.

Attack: Adjusts how quickly the sidechain detector applies expansion when a signal 
exceeds the threshold. Defaults to 1.4mS. The range is 0 to 100mS.

Hold: Keeps dynamics from being triggered again until a certain amount of time has 
passed, in mS (milliseconds). Defaults to 0mS. The range is from 0 to 4000mS.

Release: Adjusts how quickly the sidechain detector stops applying dynamics when a 
signal goes back below the threshold. Defaults to 93mS. The range is 0.03 to 4.03mS.

 � Gate: A button that lets you enable these controls and switch them to perform Gating.

Threshold: Sets the signal level below which gain reduction occurs. The range is from 
-50 to 0 dB.

Range: Sets the maximum amount of gain reduction that will be applied when the 
signal falls below the gate threshold. Once the signal has fallen below the level 
determined by the gate threshold minus the gate range, no gain reduction is applied. 
The default is 18. The range is from 0 to 60.2dB.

Ratio: Unused for gate.

Attack: Adjusts how quickly the sidechain detector applies gating when a signal 
exceeds the threshold. Defaults to 1.4mS. The range is 0 to 100mS.

Hold: Keeps dynamics from being triggered again until a certain amount of time has 
passed, in mS (milliseconds). Defaults to 0mS. The range is from 0 to 4000mS.

Release: Adjusts how quickly the sidechain detector stops applying dynamics when a 
signal goes back below the threshold. Defaults to 93mS. The range is 0.03 to 4.03mS.

Compressor
The second set of dynamics parameters let you apply compression, which detects the 
envelope of an audio signal in order to automatically change its level. Typically used to detect 
and reduce the peaks of an audio signal so that the overall level can be boosted without 
clipping, reducing the dynamic range of a given signal. Compression is often used to allow 
voices to have more presence within a mix, and to smooth out changes in the levels of tracks 
with too much dynamic range for the task at hand.
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 � Compressor: A button that lets you enable Compression.

Threshold: Sets the signal level above which compression is applied.The default is 
-15dB. The range is -50 to 0dB.

Ratio: Adjusts the compression ratio. This sets the gain reduction ratio (input to output) 
applied to signals which rise above the threshold level. The default is 2.0:1. The range is 
1.0:1 to 10:1.

Attack: Adjusts how quickly the sidechain detector applies compression when a signal 
exceeds the threshold. The default is 1.4mS. The range is 0 to 100mS.

Hold: Keeps dynamics from being triggered again until a certain amount of time has 
passed, in mS (milliseconds). Defaults to 0mS. The range is from 0 to 4000mS.

Release: Adjusts how quickly the sidechain detector stops applying dynamics when a 
signal goes back below the threshold. The default is 93mS. The range is 0.03 
to 4.03mS.

Limiter
The third set of dynamics parameters let you apply limiting, which imposes a hard limit on the 
maximum level allowed for a particular signal.

 � Limiter: A button that lets you enable Limiting.

Threshold: Sets the maximum allowable output level. The default is -21dB. The range is 
from -50 to 0dB.

Attack: Adjusts the attack rate time constant of the sidechain detector. The default is 
.71mS. The range is 0 to 100mS.

Hold: Keeps dynamics from being triggered again until a certain amount of time has 
passed, in mS (milliseconds). Defaults to 0mS. The range is from 0 to 4000mS.

Release: Adjusts how quickly the sidechain detector stops applying dynamics when a 
signal goes back below the threshold. The default is 90mS. The range is 0.03 
to 4.03mS.

Aux
Lets you route that track’s channels through an Aux send bus. Each Aux bar corresponds to a 
specific Aux bus that you created. Double-clicking any of these bars opens up the Auxiliaries 
window, with which you can enable or disable auxiliaries, set each one to be routed Pre the 
channel strip or post the channel strip (the default), and set each Aux buses send level and 
pan value.

The Auxiliaries control window
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Each Aux bus you create exposes the following controls in the Auxiliaries window:

 � On: Turns that Aux send on or off.

 � Pre: Switches aux sends to be either pre or post fader.

 � Send Level: Adjusts the amount of signal sent from the selected feed to the auxiliary 
bus. The range is OFF to +10dB.

 � Pan: Provides panning across stereo aux bus destinations.

The level to which you set an Aux bus will be shown within the bar that represents that Aux bus 
in the Mixer’s channel strip.

The Auxiliaries levels shown in the 
channel strip of the Mixer

Pan
A Pan control compatible with stereo and surround panning. You can drag the panning handle 
within this control to adjust panning for stereo or surround mixing, or you can double-click this 
control to expose a large pan window. What controls are available in the pan window depend 
on the mapping of the audio track, but both stereo and surround panning controls are available, 
with corresponding numeric controls. You can either adjust panning using the graphical Pan 
control, or you can adjust specific panner characteristics using the controls to the left.

The Pan control window
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When a channel strip’s Pan control is enabled, the Pan area displays the panning that’s being 
applied. Unlike the EQ or Dynamics controls, you can adjust a channel’s panning by dragging 
the handles that appear within this small area of the channel strip.

The channel strip’s Pan indicator

The Audio Pan window contains the following controls:

 � Left/Right: Changes the balance of signal between the left and right side speakers 
you’re outputting to, depending on what speaker format you’re mixing to. At its simplest, 
accommodates stereo output.

 � Front/Back: Changes the balance of signal between the front and back  sets of 
speakers you’re outputting to, depending on what speaker format you’re mixing to.

 � Rotate: Simultaneously adjusts the left/right and front/back pan controls in order to 
rotate a surround mix about the centre of the room.

 � Spread: Only available when a linked group is selected (feature not available at the 
time of this writing). Spread adjusts the perceived size of a surround mix.

 � Divergence: Spreads the signal for an individual feed across more of the adjacent 
loudspeakers, making the perceived size of the sound source larger.

 � 2D: more

 � Boom: The send level of that track to the LFE part of the mix.

 � On: Enables this functionality.

 � Pre: Lets you adjust the “dry” part of the signal separately from the “wet” part of the 
signal when effects are applied.

Bus Assignment Buttons
Two sets of buttons let you route audio from one channel strip’s output to Sub and Main buses 
that you’ve set up for your mix.

The channel strip’s bus assignment buttons

 � Main: These buttons let you assign a track or Sub’s channels to one or more of the 
main busses.

 � Submix: These buttons let you assign that track’s channels to one or more 
submix buses.
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Arm, Solo, and Mute Buttons
Identical to the controls found in the track header controls of each timeline audio track.

The channel strip’s Arm, Solo, and Mute bottons

 � Arm: (Labeled R) Lets you enable a track to be recorded onto. 

 � Solo: Lets you mute all other tracks in order to play a track you need to focus on in 
isolation. If solo is enabled for multiple tracks, all soloed tracks will play, and all non-
soloed tracks will be muted. This affects rendering, so if one or more tracks are soloed, 
the muted tracks won’t be output or rendered.

 � Mute: Disables audio playback from that track. This affects rendering, so if one or more 
tracks are muted, they won’t be output or rendered.

Fader Controls
Each track’s vertical fader lets you control the level that’s output by that track, either using your 
mouse, or using the physical fader of your Fairlight console. If you’re working with a console, 
then the onscreen faders serve as a visual reference of what levels are set.

The fader area

TIP: You can click a button and drag across multiple channel strips to turn that button 
on or off for multiple tracks easily.
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 � dB: Shows you the volume, in decibels, that track is currently set to.

 � Fader: Each track’s vertical fader can be dragged with your mouse or other pointing 
device to adjust the volume of that track and perform automation recording. Dragging 
up increases volume, dragging down decreases volume. Fader handles turn red while 
you record levels automation, and they turn green when automation has been recorded 
for that track.

Methods of adjusting channel faders:

 � To change the level of that channel with the mouse: Click and drag any fader 
up or down.

 � To reset the level of that channel to 0 dB: Double-click a fader’s handle. This does not 
work after you’ve recorded automation for a track.
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Chapter 69

Automation 
Recording 
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Automation Recording
The Fairlight page provides simple, flexible and com prehensive facilities for recording and 
editing mix automation data. Once recorded, all feed and bus mix parameter automation can be 
played back in perfect synchronization with the audio, including channel parameters, bus 
assignments, inserts, and direct outs.

The Fairlight page is designed to allow the operator to record every static and dynamic 
parameter change you make in the process of balancing the mix of tracks in the timeline. Mixer 
adjustments may be recorded for one or multiple parameters or channels at a time. Additionally, 
more adjustments may be added with each automation recording pass, which lets you create 
complex and detailed mixes that can be frame-accurately replayed at will.

This chapter covers automation mixing using the combined controls of the onscreen mixer and 
timeline. For more information on basic mixing operations, see Chapter 68, “Track Level Mixing.”

Automation Recording 1193

What Can You Automate 1193

Automation Controls 1193

How to Record Automation 1194

Recording Automation for Multiple Tracks  1194

Recording Automation for Specific Individual Tracks 1195

Viewing Automation 1196

Overwriting Automation 1196

Playing Automation 1197
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Automation Recording
While the recording of keyframe automation is most commonly associated with either the 
on-screen mixer or the Fairlight console, you can also record automation using controls found in 
the Inspector, or using the controls of the EQ, Dynamics, and Pan windows, thereby enabling 
you to record automation for the various audio effects that you’ve applied to a track. 

Recording automation refers to creating high-fidelity data that records changes you make to 
onscreen controls and/or Fairlight console controls, in real time as the Timeline plays, that will 
then control how those parameters will play back. In this way, you can create a dynamic mix 
where different audio level, pan, and EQ, dynamics, and other audio filter settings change over 
time to fade swells of music up and down, pan the sound effect of a car driving by from the left 
to the right speaker, or slowly increase the strength of a reverb effect applied to foley footsteps 
as a character walks into a long, dark cavern.

What Can You Automate
You can record automation for nearly every control in the mixer for channel strips 
corresponding to individual tracks, track groups, or busses, including fader . Additionally, you 
can record automation for controls found in audio plugins that you use in your mix.

Automation Controls
The automation button, to the right of the transport controls, lets you show and hide the 
automation toolbar.

Clicking the Automation button displays the automation toolbar

The automation toolbar has buttons for each option that’s available for preparing to record 
automation in your mix.

Options found in the automation toolbar

The automation toolbar displays the following options:

 � Automation: Controls how automation data is recorded.

Write: Records absolute changes to control automation.

Trim: Records relative changes to control automation in order to increase or reduce 
levels that have already been recorded.

 � Touch: Defines what happens when you first adjust an automatable control.

Off: No automation is recorded.

Latch: Automation is recorded once you begin moving a control, continues recording 
after you release the control.

Snap: Automation is recorded once you begin moving a control, stops recording after 
you release the control; there is a brief interpolation from the last level you set to the 
prior recorded level.
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 � On Stop: Defines what happens when you release an automatable control.

Event: The last recorded automation value overwrites previous levels to the start of the 
next available recorded automation data (or event) in that track.

Hold: Deletes all previously recorded mixing data after what you’ve just recorded, to 
hold the last recorded level for the rest of that track.

Return: The last recorded automation value is interpolated to ramp back to the 
previously recorded automation values on that track.

 � Enables: The following buttons let you enable or disable different controls for 
recording automation.

Fader: Automates track and bus volume.

Mute: Automates the mute button.

Pan: Automates all pan controls.

EQ: Automates all EQ controls.

Comp: Automates just the Compressor controls in the Dynamics window.

Gate: Automates just the Gate controls in the Dynamics window.

Lim: Automates just the Limiter controls in the Dynamics window.

Aux: Automates the Auxiliary controls in the Auxiliaries window.

Plugins: Automates all plugins.

Misc: Automates the parameters of VST and Audio Unit plugins.

How to Record Automation
There are two different ways you can set up the recording of automation for levels, panning, EQ, 
Dynamics, and other audio controls in the mixer.

Recording Automation for Multiple Tracks 
You can use the following steps to record automated changes to any audio control in any 
control strip:

1 Open the Automation toolbar, and do the following three preparatory steps:

a Choose whether you’re going to Write new automation, or Trim automation that’s 
already recorded. Write mode is appropriate when you’re recording automation for 
the first time, or when you’re overwriting previous automation with brand new values. 
Trim mode is appropriate when you’re making incremental changes to previously 
recorded automation.

b Next, choose Touch and On Stop behaviors that are appropriate for the kind of 
automation recording you need to do. 

2 Move the playhead to the beginning of the section of the timeline you want to record 
automation for. 

3 Next, initiate playback using any method (Spacebar, L, Play button, third party or 
Fairlight audio control panel), and make whatever adjustments you want to the controls 
for which you’ve enabled automation recording. As you make adjustments, the affected 
fader control turns red to let you know you’re recording automation.

4 When you’re finished, stop playback using any method (Spacebar, K, Stop button, third 
party or Fairlight audio control panel). Automation recording stops as well.
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Once you’ve recorded automation keyframes for a particular parameter appear in an 
automation graph. This graph is not available as of the time of this writing.

Recording Automation for Specific Individual Tracks
You can use the following steps to record automated changes to controls in specifically armed 
control strips:

1 Open the Automation toolbar, and do the following three preparatory steps:

a. Choose whether you’re going to Write new automation, or Trim automation that’s 
already recorded. Write mode is appropriate when you’re recording automation for the 
first time, or when you’re overwriting previous automation with brand new values. Trim 
mode is appropriate when you’re making incremental changes to previously recorded 
automation.

b. Next, set Touch to Off, which disables across-the-board automation recording and 
requires you to arm specific tracks that you want to automate.

2 Click the automation arm button above the fader of any Mixer track to which you want 
to record automation. Even though the Touch control is set to off, moving a control on 
an armed channel strip will record automation in Latch mode.

The automation arming button 
above a fader in the Mixer

3 Move the playhead to the beginning of the section of the timeline you want to record 
automation for. 

4 Next, initiate playback using any method (Spacebar, L, Play button, third party or 
Fairlight audio control panel), and make whatever adjustments you want to the controls 
for which you’ve enabled automation recording. While you make adjustments, the 
affected fader control turns red to let you know you’re recording automation.

5 When you’re finished, stop playback using any method (Spacebar, K, Stop button, third 
party or Fairlight audio control panel). Automation recording stops as well.
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Viewing Automation
Once you’ve recorded automation keyframes for a particular parameter, they can be made 
visible in an automation graph in the Timeline. While the automation controls are visible, an 
additional pair of controls appear in the header of each audio track. A pop-up lets you choose 
which automation waveform to view, with options for Fader, Mute, Pan, EQ, Compressor, limiter, 
Aux, and Plugins controls.

Mixing automation for the Fader shown in the Timeline

At the time of this writing, automation data cannot be deleted, edited, copied, or pasted. 
However, you can use the undo command to undo automation recording immediately after it’s 
been recorded, and you can always overwrite previously written automation.

Overwriting Automation
Once you’ve recorded automation for a particular clip, you can overwrite that automation in 
subsequent passes. Using either of the previously described methods of recording automation, 
adjusting the levels of a track control with previously recorded automation displays a red line 
that shows the new level relative to the previously recorded level.

Setting new levels to overwrite previously recorded automation displays a red line

Pressing play to actually record this new automation will overwrite the previous levels 
at this new value.

Setting new levels to overwrite previously recorded automation displays a red line
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Playing Automation
After you’ve automated a mix, playing it back is as simple as moving the playhead to an area of 
the timeline prior to the recorded automation, and initiating playback. As the timeline plays, the 
onscreen controls for each automated parameter are shown in green, and move and update to 
show the recorded levels for those controls.

Green controls show which 
ones have recorded automation 
during playback
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Chapter 70

Audio Effects 
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Audio Effects
Audio plug-ins let you apply effects to the audio clips in your mix, such as echo or reverb, noise 
reduction, aural enhancement, click and pop removal, and so on. DaVinci Resolve is compatible 
with a wide variety of third party VST and Audio Unit effects for audio processing, and these 
can then be used either in the Edit or Fairlight pages. This chapter goes through the different 
methods available for applying and customizing effects for clips and for tracks.

About Audio Plug-Ins 1200

VST and VSTi 1200

Audio Units 1200

Using Audio Filters 1201

Applying Audio Filters to Main and Sub Buses 1204
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About Audio Plug-Ins
Single or multiple plug-ins can be applied to clips and to tracks. A total of 96 mono channels of 
plug-ins can be applied (a stereo plug-in uses two of these channels, a 5.1 aware plugin six 
channels, etcetera). Plugins are accessed via each track’s control strip, or via the Inspector 
which provides access to both Clip and Track plugins.

VST and VSTi
VST (Virtual Studio Technology) is an audio plug-in standard created by Steinberg. The VST 
standard allows third party developers to create VST plug-ins for use within VST host 
applications, or to create VST host applications themselves. The VST plug-in standard is the 
most widespread audio plug-in standard in use today, with thousands of available plug-ins 
spanning the gamut from EQ and compression to reverb, denoising, de-essing, aural exciting, 
and much more.

The Fairlight page supports VST effects from Mono to 7.1 – and beyond. These effects can be 
inserted on mono channels or Link Groups. If a stereo VST Effect is inserted on a LCR, LCRS, or 
5.1 Link Group, the left and right channels will be allocated to left and right Link Group channels 
automatically.

As of this writing, DaVinci Resolve uses Version 2.4 of the VST SDK (Software Development Kit). 
VST effects are available on macOS and Windows workstations.

VST Effects versus VST Instruments (VSTi)
A VST effect is a type of VST plug-in that is used to process audio. A VST effect might be a 
Reverb, Compressor or EQ. VST Instruments are typically used to synthesize sound or play 
back sampled audio. VSTis have rapidly replaced hardware synthesizers and dedicated 
samplers due to their flexibility, repeatability and low cost.

Audio Units
Audio Units are an audio plugin API created by Apple. Similarly to VST, Audio Units (AU) can 
either process audio, or work as instruments. Audio Units are only available on macOS 
workstations.
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Using Audio Filters
Once you install VST or Audio Unit effects on your workstation, they appear in the   Audio FX 
panel of the Effects Library, organized in separate categories.

Audio filters in the Effects Library

Audio plug-ins let you apply effects to individual audio clips or entire tracks worth of audio, to 
add creative qualities such as echo or reverb, or to take care of mastering issues using noise 
reduction, compression, or EQ.

Methods of applying Audio Filters to clips on the Fairlight Page:

 � To apply an audio filter to a clip: Drag any filter from the Audio FX panel of the Effects 
Library onto the clip in the Timeline you want to apply it to.

 � To apply an audio filter to multiple clips: Select all of the clips you want to apply an 
audio filter to, then drag any filter from the Audio FX panel of the Effects Library onto 
any of the selected clips.
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Methods of applying Audio Filters to tracks on the Fairlight Page:

 � To apply an audio filter to an entire track in the Timeline: Drag any filter from the 
Effects Library onto the track header.

Applying an audio filter to a whole track via the Timeline

 � To apply an audio filter to a track or bus in the Mixer: Drag any filter from the Audio 
FX panel of the Effects Library onto the clip in the Timeline you want to apply it to.

Applying an audio filter to a whole track 
via drag and drop to the Mixer

 � To apply an audio filter to a track or bus using the Mixer controls: Click the plus 
button in the channel strip of the track you want to apply an effect to, and then choose 
a filter from the pop-up menu that appears.

Applying an audio filter to a whole track via the Mixer’s own controls

To edit a clip’s audio filters:

Select that clip and open the Inspector. All audio filters applied to that clip appear 
under the volume and pan controls, with that filter’s controls appearing directly in the 
inspector.
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To edit a track’s audio filters, do one of the following:

 � Click in the background of the Timeline header to select that track, and then open the 
Inspector. Click the custom UI button for that filter to open its controls.

The custom UI button for audio 
plug-ins in the Inspector

 � Move the pointer over the plugin’s name in the Effects area of the Mixer, and click on 
the custom UI button to open its controls.

The custom UI button for audio 
plug-ins in the Mixer

Nearly all VST and Audio Unit audio filters have a custom user interface that makes it much 
easier to manipulate that filter’s controls. These can be opened from within DaVinci Resolve.

The custom audio filter interface for Izotope RX4

Methods of working with audio filters in the Inspector:

 � To rearrange the order of multiple video filters applied to a clip: Click the move up or 
move down buttons in any filter’s title bar, to the left of each filter’s Trash Can button.

 � To disable or re-enable a filter: Click the toggle button at the far left of each filter’s 
title bar.

 � To remove a filter: Click the Trash Can button.

 � To reset a filter: Click the Reset button at the far right of the filter’s title bar.

 � To open or collapse a filter’s parameters: Double-click the title bar.

 � To open or collapse the parameters of all filters: Option-click the title bar.
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Once applied to a clip or track, audio filters can also be keyframed or automated just like 
volume and pan settings, to create dynamic audio effects that change over time.

Applying Audio Filters to 
Main and Sub Buses
You can apply Audio Filters to Main and Sub Buses just like any other track, with which to apply 
any audio mastering effects operations you require to individual submixes, or even to an 
entire main.
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Chapter 71

Audio Meters and 
Audio Monitoring 
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Audio Meters and Audio Monitoring
The Meters panel, which appears at the top of the Fairlight page when it’s enabled, provides a 
visual reference of the levels of each track in your mix, along with specialized meters showing 
the buses, monitoring mix, loudness, and a Viewer for seeing the video of the current project as 
you work. This chapter describes the use of these meters, and provides information about the 
different options that are available.

The Monitoring Panel 1207

Track Meters and Monitoring Controls 1207

Using Post Fader or Track Source Meters 1208

Bus Meters 1209

Compound Meters and Output Bus Selection Menu 1209

Monitoring Menus 1210

Control Room Meters 1210

Loudness Meters 1210

What is LU? 1210

Loudness Meter Options 1211

Graphical Loudness Meters 1211

Numeric Loudness Meters 1211

Using the Loudness Meters 1212

Viewer 1212
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The Monitoring Panel
Turning on the Meters in the UI toolbar displays the Monitoring panel that runs along the top of 
the Fairlight page, which shows all of the audio meters that correspond to the tracks in the 
Timeline, as well as the Bus meters that correspond to the Mains, Subs, and Aux buses of your 
mix, the Control Room meters, and a video viewer.

The Monitoring panel

Track Meters and Monitoring Controls
At left, a row of audio meters corresponds to the channel strips of the Mixer, one meter for 
every audio track in the timeline. Each track displays the number of meters that corresponds to 
that track’s audio mapping, with mono tracks having a single audio meter, stereo tracks having 
two, 5.1 tracks having six, etcetera.

Track audio meters with different numbers of meters 
depending on that track’s audio mapping

Each track and bus meter (with the exception of the Loudness meters) display RMS (root mean 
square) levels against a dB scale. A single line indicating the maximum value at any given 
moment in time is held briefly just above the current RMS levels, which appear as a solid bar 
extending from the bottom of the meter. RMS meters display a weighted “average” 
representation of the audio level that’s closer to the way audio is actually perceived, although 
not as accurate as the loudness meters discussed later in this section.
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Each meter bar is color coded to indicate two different thresholds of sound level, from low 
(green) to high (yellow) to very high (red).

The peak meter at top 

Each meter is identified by the track number it represents (track names are not shown over 
track meters) as well as the color of that track.

Using Post Fader or Track Source Meters
The Track Meters setting in the General Options of the Project Settings lets you choose how 
meters in the Fairlight page display their audio analysis. There are two options:

 � Post Fader: Meters always display the level of each clip’s signal after whatever fader 
adjustments have taken place. Fading a track’s level down diminishes the visible level 
of that audio signal in the meter. This setting is good if you prefer a visual indication 
of the relative levels you’ve set your various audio tracks to, which is a very NLE-
oriented behavior.

 � Track Source: Meters always use the volume levels of the audio clips in that track, 
even if you’ve lowered the level using the sliders. If you’ve keyframed a clip’s volume, 
that change will be reflected by the audio meters, even though fader changes are not. 
Viewing meters this way means you can always see how much level is available to clips 
in your mix regardless of what the current fader levels are set to, in the event you want 
to keep track of audio you want to bring back into the mix later on. This is a very DAW-
oriented behavior.
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Bus Meters
To the right of the Track Meters are the bus meters, in which all Mains, Subs, and Aux buses 
appear, separated by type, and each displaying the number of meters that corresponds to that 
track’s audio mapping. This way you can see the sum of all tracks that have been routed to a 
particular bus.

Bus meters for the Mains, Subs, and Aux buses

Compound Meters and 
Output Bus Selection Menu
The Compound Meters, to the right of the Bus meters, consist of Control Room meters and 
Loudness meters, shown side-by-side to provide a comprehensive analysis of your overall 
audio mix. Below, pop-up menus let you choose which bus you want to monitor, as well as 
which set of speakers you want to use to do the monitoring.

The Control Room meters (at left),and Loudness meters (at right)
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Monitoring Menus
The Monitoring Menus determine which bus gets analyzed by the Compound Meters. When the 
Compound Meters are displayed, the Monitoring pop-up menu that otherwise appears to the 
left of the monitoring controls in the Transport toolbar instead moves to a position underneath 
the Loudness meters. 

The monitoring menu lets you choose which 
bus you want to monitor while working

The next pop-up menu to the right lets you choose one of the available sets of speakers once 
you’ve configured them in the Video and Audio I/O panel of the System Preferences. This gives 
you the flexibility to quickly listen to your mix on a variety of speakers and configurations to see 
how it holds up in different situations. For more information on configuring different speaker 
setups, see Chapter 3, “Project Settings and Preferences.”

The monitoring menu lets you choose which bus 
you want to monitor while working

Control Room Meters
The mustard colored Control Room audio meters show the sum of all audio channels that are 
routed to the currently selected bus being monitored (as selected in the pop-up menu below). 
These are peak meters measured in dBFS.

Loudness Meters
The set of meters all the way to the right are the Loudness meters, which consist of a set of two 
graphical meters and a numerical readout. These meters let you analyze the “integrated 
loudness” of the overall mix, which is the standard to which all contemporary mixing 
specifications refer when describing the deliverables you’re expected to provide to the client. 
Unlike the RMS audio meters found in the Timeline or mixer which measure audio in dB, 
loudness meters do a different kind of analysis, measured in LU (loudness units).

What is LU?
A value of 1 LU (loudness unit) represents the smallest difference in audio levels that 
humans can actually perceive. Human hearing naturally sums all channels that reach 
the ear, so the summed channel meter to the right in the Compound Meters is an 
analysis of the loudness you actually hear.
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Loudness Meter Options
Two options in the General Options of the Project Settings let you customize the 
Loudness Meters. 

 � Target Loudness level: Lets you set the LUFS value that’s used as a reference level 
for loudness metering. Defaults to –23 LUFS which conveniently makes the display of 
these meters scale similarly to traditional audio meters that you’re already used to.

 � Loudness Scale: Lets you choose which scale you want to use with which to measure 
the meters. Options currently include the default of EBU +9 Scale (–18 to +9), and EBU 
+18 Scale (–36 to +18).

Graphical Loudness Meters
Two separate meters give you a dynamic graphical measurement of the Loudness of the 
selected bus being monitored according to the ITU-R BS.1770-3 and EBU R128 standards, which 
describe how to analyze the subjective loudness of a given audio mix for purposes of 
compliance with required quality control (QC) standards.

 � A steel-blue meter labeled M (for momentary) has as many channels as the selected 
bus you’re monitoring, excluding the LFE channel(s) of surround formats, which aren’t 
factored into loudness metering. This meter measures LEQ (equivalent sound level), 
within a 400ms window following the playhead as measured every 100ms. This lets 
you evaluate the LUFS (Loudness Units Full Scale) level of the mix at the current frame 
as you play. This discrete-channel analysis is used to calculate all other values of the 
loudness metering system.

 � A second steel-blue mono meter to the right displays the sum of all channels in the 
M meter, displayed in LU (loudness units). The numeric value displayed at the top of 
this meter is the maximum LU value that’s been analyzed during any stretch of timeline 
playback. This value is held until it’s reset, either by stopping and initiating playback a 
second time while Link to Playhead is enabled, or when you click the Reset button at 
the bottom of the loudness meter area.

Numeric Loudness Meters
A set of values to the right of the meters give running reports on the audio level of your mix. 
While the graphical meters are useful for analyzing your mix as you work, these numeric 
readouts are particularly valuable for providing the strict information you need to adhere to 
written QC standards. Their meaning is as follows:

 � Short: Measures the average LU level over a 30 second window following 
the playhead.

 � Short Max: Shows the maximum level over the same 30 second window. This analysis 
is required by EBU R128.

 � Range: Measures the dynamic range of the Loudness of your mix (in LU), which is the 
difference between the average soft and average loud parts of your mix. Analyzes the 
overall loudness over a played range of the mix, discounts the lowest 10% and highest 
5%, and then gives a standardized expression of the difference between the remaining 
soft and loud levels that were analyzed. The window of analysis is as long as you’ve 
been playing. This analysis is required by most QC specifications.

 � Integrated: Measures the LUFS value of the portion of the range of the mix you’ve 
played through. As you play, this integrated value accumulates. This analysis is required 
by most QC specifications.
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Using the Loudness Meters
When using the Loudness Meters to do a structured analysis of your mix to determine QC 
adherence, a group of controls let you determine when analysis begins and ends.

 � Lock Metering to Transport: This setting is found in the Compound Meter option menu. 
When enabled, all Loudness Metering analysis is automatically reset whenever you 
move the playhead to another location in the Timeline. This is useful when you’re spot-
checking different parts of your mix, or working on a particular scene.

 � Pause and Reset buttons: When you’re doing a formal analysis of your mix, the Reset 
button lets you reset all currently accumulated analyses, and the Start button initiates 
loudness value accumulation. If you need to stop playback briefly to do something else, 
you can click Pause, and then click Resume when you’re ready to continue the analysis.

Viewer
A small viewer to the left of the Monitoring panel shows the frame of video at the position of the 
playhead. This is the same image that’s output to the external broadcast display of your 
workstation if you have one connected.

The Viewer lets you see the picture you’re mixing to

Clicking the Expand Viewer button at the bottom right-hand corner lets you open the Viewer 
into a floating window, which you can then position anywhere you want.

To close the floating Viewer, click the Dock Viewer button at the upper right-hand corner of the 
floating viewer window.

Click this button at the upper right-hand corner to dock the Viewer again
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Chapter 72

Signal 
Flow Diagrams 
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Signal Flow Diagrams
The diagrams in this chapter describe the audio signal flow that takes place within the Fairlight 
audio processing used by DaVinci Resolve. They’re intended for people who want an in-depth 
understanding of how audio is processed.

Signal Flow Overview 1215

Audio Processing Path 1216
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Signal Flow Overview
The following simplified flow diagram describes Fairlight audio processing overall.
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Audio Processing Path
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